
Use of CFD in Design: A Tutorial
Sean M. McGuffie, P.E.

Michael A. Porter, P.E.

Thomas T. Hirst

Contents

1 About the Presentation 3
1.1 About the Authors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2 Introduction 4
2.1 What is CFD? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.2 History of CFD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
2.3 Why use CFD? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
2.4 Common Terminology and Abbreviations . . . . . . . . . . . . . . . . . . . . . . . . 14

3 Mathematics 15
3.1 Lagrangian vs Eulerian Formulations . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
3.2 Navier Stokes Equations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
3.3 Overview of Solution Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

4 The CFD Modeling Process 22
4.1 Example 1: Mixing Tank . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
4.2 Understand the Physics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
4.3 Define Computational Volume . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
4.4 Create the Computational Grid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
4.5 Select Physics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
4.6 Apply Boundary Conditions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
4.7 Initialize Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
4.8 Solve . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

5 Example 2: Flow Between Parallel Plates 40
5.3 Create a Computational Grid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
5.4 Select Physics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
5.5 Apply Boundary Conditions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
5.6 Initialize Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
5.7 Solve . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
5.8 Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

6 Introduction to Turbulence 52
6.1 What is Turbulence? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
6.2 Can CFD Handle Turbulence? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

7 Example 3: Waste Heat Boiler Ferrule 58
7.1 Understanding the Physics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
7.2 Select the Computational Volume . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
7.3 Create the Computational Grid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69



7.4 Selection of Physics Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
7.5 Applying Boundary Conditions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
7.6 Initializing the Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
7.7 Solve . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

8 Advanced Topics 104
8.1 DES and LES Turbulence Modeling . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
8.2 Porous Media . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
8.3 Radiation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
8.4 Multi-Component Flows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

9 Summary 107



USE OF CFD IN DESIGN 1 ABOUT THE PRESENTATION

1 About the Presentation

This tutorial was developed at the request of the ASME Design and Analysis Committee as a
means of providing information regarding the state of the art in computational fluid dynamics
(CFD). Employees of Porter McGuffie, Inc. (PMI), specifically, Mike Porter, Sean McGuffie, and
Tommy Hirst developed this tutorial. Sean and Tommy extend their gratitude to Mike for provid-
ing the resources that made its development possible.

PMI strove to make this tutorial as software-independent as possible. Instead, we worked to
incorporate fundamental concepts, using models available in most commercial CFD codes. For the
examples included in this tutorial, we used Star-CCM+, a product developed by CD-Adapco. On
the flash drive supplied to you are electronic copies of the course materials, including:

• PowerPoint presentation

• PDF course manual

• Selection of model files

Adapco has offered a free one (1) month trial license of their software if you desire to “play” with
the model files. Attendees may obtain a no-cost 30 day license to use STAR-CCM+ for partic-
ipation in this event (subject to export control compliance and end user license agreement). To
obtain your license, contact Eric Volpenhein of CD-adapco [eric.volpenhein@cd-adapco.com ; (513)
574-8333].

In the manual, PMI has included basic instruction sets for most of the software demonstrations that
will occur. These instructions are written in standard software use format. Take the Star-CCM+
Commands illustrated below:

Star-CCM+ Commands

1. File →New Simulation →OK

2. File →Import Volume Mesh →ex1-mesha.ccm

When items are indicated within boxes similar to those above, they are commands that will be
issued during the tutorial. Thus if attendees would like to perform the same actions as shown in
the software, they may do so by following the commands within the Star-CCM+ Commands boxes.
This particular command directs the user to approach the File menu, then select a New Simulation
and click OK in Step 1. Step 2 is also using the File menu and performing the action of importing
a mesh. For sub-menus within Star-CCM+, the command box will be indented to indicate going
further within any particular menu. Most commands will involve a left click action to proceed.
When necessary right clicks or other actions are generally specified separately.

We encourage the participants to take advantage of the trial software and sample models provided;
it is only through practice modeling that you can understand the concepts presented today.

We have 3.5 hours to cover the information contained in thousands of pages of introductory texts.
As such, we’re going to make your head spin at the rate that information comes to you. And we
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USE OF CFD IN DESIGN 2 INTRODUCTION

are just going to touch the surface. You won’t walk out of this tutorial feeling like you can tackle
any CFD problem with zero difficulty. But, you should walk out with fuller knowledge of what’s
possible, potential pitfalls and a better understanding of how complex problems can be. PMI will
be at the conference until noon on Thursday, feel free to seek us out with questions that might
occur to you following today’s tutorial.

1.1 About the Authors

Sean M. McGuffie, P.E. (sean@pm-engr.com) - Sean is a Senior Engineer with PMI. He has been
performing CFD for the past 16 years and is familiar with most commercial CFD packages. Sean
is the lead author for the tutorial and is responsible for the following sections:

• General Procedures for CFD Analyses

• Modeling Turbulence

• Example 3 - CFD Analysis of a Waste Heat Boiler Ferrule System

• Advanced Topics

Tommy T. Hirst (tommy@pm-engr.com) - Tommy is currently a graduate student at the University
of Kansas pursuing a Masters in Mechanical Engineering with a focus on finite element analysis
and continuum mechanics. Tommy has been working with PMI on CFD and FEA problems for
the past year. Tommy is a secondary author of this tutorial and will be presenting the following
sections:

• Mathematics

• Example 2 - Flow Between Parallel Plates

Michael A. Porter, P.E. (mike@pm-engr.com) - Mike is the principal engineer of PMI, an ASME
fellow and a long time practitioner of numerical simulations. His participation in this tutorial is
limited to:

• Why Perform CFD?

2 Introduction

Recent advances in computational resources have made the use of computational fluid dynamics
(CFD) to support industrial design activities more commonplace. While large and small organiza-
tions have adopted the technology, it is still considered “magic” by most engineers. The purpose
of this tutorial is to provide the design engineer with an understanding behind the fundamental
concepts related to successfully performing CFD analyses, and to discuss how they can be incor-
porated into design processes.

The tutorial is organized into two sessions. The first session will provide an overview of the CFD
modeling process, including:

• What is CFD?

• Why perform CFD?

• A general outline of the Navier-Stokes equations and their solution, and
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USE OF CFD IN DESIGN 2 INTRODUCTION

• An overview of the general steps required for all CFD analyses (with mixer example)

These preliminary concepts will then be reinforced through the solution of a “simple” CFD model.
During the solution of the problem, the concepts of establishing solution monitors and using them
to monitor convergence will be discussed.

The second session will cover more advanced concepts, including:

• General discussion of turbulence,

• Numerical methods for turbulence modeling,

• Example of turbulence modeling with a waste heat boiler (WHB) ferrule assembly, and

• A general discussion of more advanced topics

During the tutorial, several industrial examples will be shown to demonstrate the topics.

2.1 What is CFD?

Computational fluid dynamics, commonly referred to as CFD, is the solution of a system of partial
differential equations (PDEs) to determine a numerical solution of a problem. The dictionary defi-
nition of computational fluid dynamics is “the prediction of the behavior of fluids and of the effects
of fluid motion past objects by numerical methods rather than model experiments” [1]. In general
the solution of the PDEs of a particular flow physics are laboriously difficult or nearly impossible
and cannot be solved analytically except in special cases [2]. This allows numerical experiments
to be performed without the need for full-blown experimental results on a problem by problem basis.

Numerically, several different mathematical formulations are used to solve a system of PDEs. These
include, but are not limited to:

1. Finite difference method (FDM)

2. Finite element method (FEM)

3. Finite volume method (FVM)

Currently the finite volume method is the method of choice for implementation within the majority
of commercially available software packages. However, other methods have been shown to achieve
accurate results. Finite volume methods (and all numerical methods) are used to create an approx-
imation using discretizations of the problem physics [2].

CFD is useful and has become growingly popular for some of the following reasons [3]:

• CFD allows numerical simulation of fluid flows, the results for which are available for study
even after the analysis is over.

• CFD allows observation of flow properties without disturbing the flow itself, which is not
always possible with conventional measuring instruments.

• CFD allows observation of flow properties at locations which may not be accessible to mea-
suring instruments.

• CFD can be used as a qualitative tool for discarding (or narrowing down the choices between)
various designs.
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2.2 History of CFD

The growth of CFD, as currently recognized, began in the 1970’s at the same time as the rise of
the computer, the 1970’s. Computational fluid technologies has paralleled that of computational
technologies. As computational power has grown so has CFDs capability to deal with extreme
complexities. In the 1980’s the introduction of both 2D and 3D models began as well as the quest
to conquer the Navier-Stokes equations, considered the holy grail of CFD modeling at the time
. Enhancements of CFD were spurred on by aviation, aerospace, nautical, and development of
turbo-machinery [4].

Along with the development of CFD came the need to develop more complex algorithms of grid
generation, also referred to as mesh generation. Meshing technology began with simple algorithms.
As the need for more complex geometries became apparent, so did the schemes to create meshes for
them [4]. Mesh generation has evolved to include non-matching grids (i.e., cells do not align) and
can now take many forms: tetrahedral, prism-based, hexahedral, etc. While meshing technology
began with the use of the tetrahedron, as they are easier to create, research has shown that the use
of prism or hex grids should be used in viscous flow regions [4]. Grid generation has continued to
develop and now includes automeshing and mesh adaptation. Attempts have been made as much
as possible to remove the user from the mesh and allow the solution to determine mesh adaptation.
However, this goal has not been completely realized.

Today CFD is used routinely in product development for the common historical uses such as aircraft,
automobiles and turbo-machinery to newer uses such as chemical processing. Models consisting
of thousands or even millions of cells can be solved in a mere few hours, far faster than at the
beginning of the technology’s development. However, CFD is not a mature technology [4]. In fact
there are still many areas under study both in academia and in industry. Examples include mesh
adaptation, solid-liquid interaction, more advanced constitutive theories, and the ever pressing issue
of flow turbulence. Today, the most engineers may not be able to pick up and create a CFD model
without any background knowledge, the technology is becoming both easier and more accessible.

2.3 Why use CFD?

When I was in college, the best calculation tool that we had was the slide rule. With it, we were
expected (by most) to calculate numerical values to the nearest two significant figures. A few over-
bearing professors demanded answers to 3 significant figures and at least one demented individual
would comment (negatively) with questions about the 4th significant figure. The slide rule wasnt
a perfect calculating tool, but it was the best one we had at the time. Im not old enough that the
computer had not been invented when I was in school, but batch processing punched cards with
an often delayed print-out of the results was the best that you could expect, even at a large and
well-funded university.

As an engineer fresh out of school, I was able to convince my employer to pop for nearly $400 to
purchase an HP-35 scientific calculator. Not only would it do basic multiplication and division,
but this new piece of technology would compute square roots as well as deal with trigonometric
functions. It was totally a marvel at the time. Again, that relatively simple tool was the best tool
that we, as engineers had at the time.

In the early 1980’s the personal computer hit the engineering scene and we saw another revolution
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in the “best tool we had” progression. Later on in in that decade we saw the introduction of finite
element analysis on the personal computer. This made an analysis tool accessible to the commer-
cial engineering community that had been the nearly exclusive tool of academics and very large
company researchers. A new “best” in engineering analysis tools was established.

Concurrent with the development of FEA was the development of CFD. However, CFD is an inher-
ently non-linear computational process. The solution of CFD problems requires orders of magnitude
more computing horsepower than does FEA. The early CFD codes (dating back to the late 1960’s)
used many simplifying assumptions to permit solution on the existing computer horsepower. It was
not until the 1990’s that a practical solution of the full Navier-Stokes equations were developed.
Primarily (although not entirely) due to the computational requirements, CFD did not become a
common tool for the commercial engineering community until the last decade or so. At that, its
use in general industry is still quite limited.

All of which brings us to the question of why one would choose to use CFD?

CFD allows one to model and predict the behavior of many different physical phenomena. Like the
many uses of FEA, there are many possible uses of CFD; way too many to cover exhaustively here
today. Instead, we are going to discuss some of the most relevant issues for the PVP community.
The phenomena covered in the following sections are not ordered by any relative importance. I
suspect that you many find some of the areas relevant and others not so much. I also suspect that
each of you may see differing areas of importance depending on your circumstances.

2.3.1 Flow

Probably to first issue than comes to mind when most folks think about CFD is flow. We can all
relate to the wake that surrounds and follows a ship moving through the water. As engineers, we
are also a similar wake that surrounds an airplane as it flies. However, at sub-sonic speeds we don’t
have any visual clue as to the extent of this wake. It is not surprising then, that the aerospace
industry was the lead developer of CFD. Im going to look at something quite different from an
aircraft as an example of flow. We are going to look at the inlet to a baghouse. This is a rather
mundane, but nonetheless necessary device used in many diverse industries to remove particulate
matter from a gas stream. Playing an overriding role in the behavior of the particulates is the way
that the gas flows.

Figure 2.1 shows the baghouse in question. The large rectangular section above the inverted pyra-
mid hoppers is the baghouse proper. The particle laden flow enters through the circular duct near
the horizontal center of the baghouse. Note that there is a right angle elbow less than a duct
diameter from the entrance. It doesn’t take a lot of CFD experience to imagine that this might
pose some kind of problem.
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Figure 2.1: Baghouse

If we went inside the baghouse’s inlet duct we would see the the accumulation shown in Figure 2.2.
What you see is particle accumulation (almost like gravel in this case) on the floor of the inlet
duct. The depth of accumulation in this case is approximately 2-3’. This accumulation was causing
increased pressure drop in the system and, when it built up enough, the user would get a mini-
landslide that would literally clog the works.
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Figure 2.2: Looking into Baghouse

How would CFD be helpful here? First, it allows us to “see” the flow in the area of concern.
Figure 2.3 is an iso-surface showing the 3 m/s velocity profile in the duct. Above this surface, the
velocities are higher; and below correspondingly lower. Note in particular that the low velocity
region shifts from one side of the duct to the other between the second and third hopper. The low
velocity flow allowed the particulate to drop out of the air flow before in entered the hopper, causing
the accumulation. Straightening the flow to eliminate the low velocity zones near the bottom of
the duct was the key to solving this problem.

Figure 2.3: 3 m/s Velocity Iso-Surface
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This problem was compounded by the fact that changing the inlet duct geometry was not consid-
ered a financially feasible solution to the problem. It turned out that installing a rather unique
set of vanes in the duct did solve the problem without adding a significant amount of pressure
drop. Figure 2.4 illustrates the turning vane configuration developed with CFD for this problem.
These vanes were installed some time ago and effectively eliminated the problem with no noticeable
pressure drop increase.

Figure 2.4: Inlet Turning Vanes

2.3.2 Pressure Drop

This leads us into a second phenomenon, pressure drop. It takes power to overcome pressure drop
and power costs money. The cases where pressure drop is not a significant cost on the processing
side of our industries are few and far between. Consequently, reducing pressure drop can result in
significant savings and, thus, is a significant goal on its own.

As an example, we will look at a large horizontal heat exchanger, illustrated in Figure 2.5. On
the left side, we see the geometry for the inlet and exhaust headers on a three inlet and 2 outlet
piping system. On the right is illustrated a 4-inlet and 2-outlet system. The available compressive
horsepower for this proposed system was very limited, so the goal was to evaluate the pressure drop
and select the best configuration.
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Figure 2.5: 3-Inlet and 4-Inlet Piping Systems

Using CFD, the flow through the system under actual operating conditions can be modeled. Rather
than using empirical values, it is possible to compute the actual pressure drop to the flow paths and
the interaction between the various disturbances in the path. What we found was very interesting.
Not only was neither of the proposed designs optimal, but a significant reduction in the system
pressure drop could be achieved in a way that also resulted in extended catalyst life.

Figure 2.6 illustrates the piping configuration that was arrived at using CFD. While meeting the
required pipe flexibility requirements, this design lowered the pressure drop to less than 3/4 of water
column, while providing very even distribution between the reactor inlets. More importantly, the
analysis revealed that the normal design would produce significant by-passing of the flow along the
walls of the vessel, as illustrated on the left in Figure 2.7. Changes in the inlet geometry resulted
in the much more even flow illustrated on the right in Figure 2.7.

Figure 2.6: Inlet Piping Configuration
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(a) Original Flow Velocity (b) Modified Flow Velocity

Figure 2.7: Reactor Bed Flow

We can see that with the original configuration there was high velocity by-pass along the outside
walls, which would result in under-use of the catalyst in the center of the bed. In the modified
reactor, this has been eliminated. Although we dont know precisely how much this has saved, we
do know that the catalyst, thus far, has exceeded its original planned life.

2.3.3 Heat Transfer

In the third example problem, later on, you will probably learn more that you ever wanted to know
about heat transfer computation with CFD. For now, let me simply state that heat transfer is a
prime use of CFD in industry. It is much more powerful than the normal capabilities found in finite
element analysis.

2.3.4 Mixing

Although the first example problem will cover some of the aspects of mixing analysis using CFD
in more detail, the short story is simple mixing can be calculated very effectively. As an example,
in the bubble column reactor, a gas is passed through a liquid bed that normally maintains a solid
catalyst in slurry form. Both mixing and heat transfer are important issues in the proper and
economical operation of these systems. A cross-section of a typical reactor is illustrated on the left
in Figure 2.8, showing the lower portion of the reactor shell and the internal heat removal tubes.
The right side of Figure 2.8 illustrates the velocity profile within the model. This data can be used
to evaluate mixing. Note three phases are included in this model, the gas, liquid and solid.
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(a) Cross Section of Bubble
Column Reactor

(b) Bubble Column Reactor
CFD Model

Figure 2.8: Slurry Bubble Column Reactor

2.3.5 Particle Trajectories

Any time that flows involve particles, the particle trajectories can become important. In the first
example in this section we looked at a bag house where particle accumulation was a problem. CFD
can be effectively used to follow the path of the particles and accurately predict where the particles
will go. CFD also allows for the prediction of phenomena like wear. Figure 2.9 shows particle
tracks through a drop-out box developed for placement upstream from the baghouse.

Figure 2.9: Particle Trajectories through Drop-Out Box

2.3.6 Other Advantages

There are a host of advantages to the use of CFD. Below is a short-summary of other advantages.

• Allows modeling of phenomena that cannot be physically tested:

– Too large of a domain for physical testing

– Impossible to achieve similarity
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– Too dangerous to physically test (deflagration, explosion risk)

• Allows data sampling at any point in the domain

• Visualization of flow variables is more robust than can be achieved in physical testing

• Allows design refinement

• Cost

In summary, CFD is not the be-all end-all as an engineering tool, but is one of the best that we
can employ today.

2.4 Common Terminology and Abbreviations

2.4.1 Abbreviations

CFD Computational Fluid Dynamics

DNS Direct Numerical Simulations

FEM Finite Element Method

FVM Finite Volume Method

GPM Gallons per minute

LES Large Eddy Simulation

PDEs Partial Differential Equations

Re Reynolds Number

2.4.2 Definition of Common Terms

Automeshing The ability of a software package to construct a mesh independently
of user interaction

Bias Stretching the length of a mesh in one or more directions

Grid or Mesh Computational grid used to construct cells for a CFD solver

Kolmogorov Scale The turbulent scale where all eddies are considered isentropic and the
eddy energy is dissipated through viscous effects

Navier Stokes Equations System of partial differential equations governing the behavior of a
fluid or gas

2.4.3 Definition of Common Mathematical Symbols

Note: The symbols included in this list are indicative of the symbols used in this manuscript. There
are several notations that differ between fields of study and among authors of various reference texts.
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D
Dt The material derivative can be defined as the operator ∂

∂t + v · ∇
µ Dynamic viscosity [Pa

m2 ]

µt Turbulent viscosity

ν Kinematic viscosity

Ω Representation of a mathematical domain or control volume

ρ Density of a material

σ Stress tensor

τw Wall shear stress

T Deviatoric stress tensor

e Specific energy density

f Body forces per unit volume

k von Karman constant

m Mass of a material

P Pressure

q Heat vector

u Velocity parallel to the wall (when referenced with law of the wall)

u+ Dimensionless velocity, velocity parallel to the wall as a function of y

ur Shear velocity

y Distance from wall

3 Mathematics

3.1 Lagrangian vs Eulerian Formulations

In deformation analysis there are two common descriptions of how to analyze the motion of mate-
rial particles: Lagrangian and the Eulerian descriptions. Lagrangian formulations involve tracking
individual particles as a function of placement in the reference configuration and time. In this de-
scription the observer is attached to the material particle and has the ability to know this specific
material particle’s location throughout time. Eulerian descriptions are a function of material place-
ment in the current configuration and time. In this description, attachment to material particles is
foregone and observations are made at a point in space. Thus, in Eulerian descriptions the ability
to track individual material particles has been lost.

A proper analogy is that of a speeding motorist. If the motorist happened to be followed by a
police officer, and the police officer recorded his speed and position, this would be a Lagrangian
description, i.e., the police officer is aware of the motorist’s movement and speed. Next, let’s assume
that the same motorist is speeding once again. This time the police officer is hidden on the side of
the road. As the motorist passes by, the officer records his speed. The police officer is aware of the
motorists speed in a given location, but is not following the motorist. This would be an Eulerian
description.

Due to the exotic motion of fluids, it is difficult, or impossible in some instances, to track individual
material particles. Thus fluids and gases typically use an Eulerian frame of reference. Individual
particles are not tracked; the user is aware of the necessary variables (such as velocity) in a given
region. Or in the case of the finite volume method, within the control volume. Within this document
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all mathematical models are presented in an Eulerian description.

3.2 Navier Stokes Equations

The Navier-Stokes equations result from the conservation of momentum coupled with conservation
of mass, energy, and possible equations of state. In a non-reduced form, they create a complete
mathematical model of the fluid. However, because of the complexity of the Navier-Stokes equa-
tions, including nonlinearity, they are not easily solved analytically with the exception of a few
special cases [5]. The complexity of these equations is the reason behind using a computational
method to calculate a numerical solution.

During the tutorial, it will be shown that the Navier-Stokes equations do not come without as-
sumptions. Assumptions about the equations of state governing thermodynamic relations as well as
assumptions in the heat vector can affect the solution. The Navier-Stokes equations for Newtonian
fluids also make assumptions for the stress tensor, which then further requires the knowledge of ma-
terial constants. Thus, the direct solution of the continuity equation (resulting from conservation
of mass), balance of momenta, and conservation of energy are complete when given a constitutive
theory and a necessary equation of state. However, these equations are often simplified on a case
by case basis to ease in the solution.

3.2.1 Conservation of Mass

Consider a finite control volume Ω in which lies the continuum under consideration. The material
in this continuum has a mass m, and a density ρ within the control volume Ω. The mass within
the control volume can be represented in terms of ρ in an integral form as:

m =

∫
Ω

ρ dΩ (3.1)

In the absence of mass sources and sinks, the mass in the control volume Ω is conserved; hence,
the rate of change of mass within the control volume must be zero [6].

Dm

Dt
=

D

Dt

∫
Ω

ρ dΩ

 = 0 (3.2)

By applying Reynolds transport theorem, (3.2) can be represented as∫
Ω

(
∂ρ

∂t
+∇ · (ρv)

)
dΩ = 0 (3.3)

This equation must hold for any arbitrary control volume. This can only occur if the integrand is
equal to zero. Thus this can be simplified to;

∂ρ

∂t
+∇ · (ρv) = 0 (3.4)

(3.4) is called the continuity equation (in an Eulerian description) and is representative of the
conservation of mass [6]. This applies to both compressible and incompressible fluids. A description
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of the meaning of these terms can be seen in (3.5).

∂ρ

∂t︸︷︷︸
Accumulation of Mass

in a Fixed Element

+ ∇ · (ρv)︸ ︷︷ ︸
Net Flow Rate
Out of Element

= 0 (3.5)

If we assume that the fluid is incompressible, then density is constant throughout the computational
domain. Thus, it has neither dependence on time nor space and (3.4) can be reduced to[6]:

∇ · v = 0 (3.6)

3.2.2 Conservation of Momentum

We can proceed with the derivation of the conservation of momentum in a similar fashion as the
conservation of mass show in Section 3.2.1. This can be shown by stating that the time rate of
change of momentum within a control volume Ω is affected by external body forces and internal
forces created by stress within the continuum. Following the derivation (not shown), the resulting
equation for conservation of momentum can be shown to be [6]:

ρ
Dv

Dt
= ∇ · σ + f (3.7)

where σ is the stress tensor and f is the total body forces applied per unit volume.

This form of the momentum equation is helpful in deriving the conservation of energy equation [6].
However, (3.7) can be presented in several different forms depending on the necessary criteria.

3.2.3 Conservation of Energy

Like the conservation of mass in Section 3.2.1 the conservation of energy can be developed over a
control volume using basic laws. As in Section 3.7, we will forgo the derivation of the conservation
of energy and will present the final conservation of energy equation as [6]:

ρ
De

Dt
+∇ · q − σ · ∇v = 0 (3.8)

where e is the specific energy density and q is the heat vector. The details of the specific energy
density and the heat vector result from constitutive theory and thermodynamic relations.

3.2.4 Navier Stokes Equations

The Navier Stokes equations are a system of equations that describe the conservation of mass, the
conservation of momentum, and the conservation of energy. These are shown in (3.9). These still
require a constitutive theory, an equation of state, and a description of the heat vector (generally
Fourier heat conduction).

∂ρ

∂t
+∇ · (ρv) = 0

ρ
Dv

Dt
= ∇ · σ + f

ρ
De

Dt
+∇ · q − σ · ∇v = 0


(3.9)

17 of 110



USE OF CFD IN DESIGN 3 MATHEMATICS

3.2.5 General Form of Navier Stokes Equation of Motion

The most general form of the Navier Stokes equation of motion results from the conservation of
momentum in (3.7). It is convenient to regard the stress tensor σ as the sum of the isotropic part,
having the same form as the stress tensor of a fluid at rest and a remaining non-isotropic part T
[7]. The non-isotropic part T may be called the deviatoric stress tensor, and has the distinctive
property of being due entirely to the existence of the motion of the fluid [7]. Decomposing the
stress tensor σ into its two components we obtain [7]:

σ = −pI + T (3.10)

Substituting this definition of the stress tensor into the momentum equation in (3.7) we obtain:

ρ
Dv

Dt
= −∇p+∇ · T + f (3.11)

where p is a scalar quantity, being the static-fluid pressure. (3.11) is the general form of the Navier-
Stokes equation. However, this model is incomplete without an equation of state and an energy
equation (if the fluid is considered incompressible), and a constitutive theory for the deviatoric
stress tensor.

3.2.6 Incompressible Newtonian Navier Stokes Equation of Motion

The incompressible Newtonian Navier-Stokes equations are a special subset of the Navier-Stokes
equations that are used in many cases. Fluids in which the shearing stress is linearly related to to
the rate of shearing strain are designated as Newtonian fluids [5]. This result can be seen in (3.12).

τ ∝ ∂u

∂y
(3.12)

This assumption is common for fluids such as water, oil, gasoline, and air. The relationship is
continued by a linear relationship to the dynamic viscosity µ of a fluid. Values of the dynamic
viscosity depend both on the temperature of the fluid and the fluid itself.

τ = µ
∂u

∂y
(3.13)

For an incompressible Newtonian fluid we can make the following assumptions:

• Density is constant, and we can apply the continuity equation ∇ · v = 0 shown in (3.6).

• The fluid is isotropic (i.e., material properties are the same regardless of orientation).

• The stress tensor is linear in the strain rates and is related through viscosity as shown in
(3.13). This leads to the following for the deviatoric stress tensor T expressed in Einstein
tensor notation [5] [7]:

Tij = µ

(
∂ui
∂xj

+
∂uj
∂xi

)
(3.14)

If we replace the deviatoric stress tensor in the general Navier-Stokes equation in (3.11) with the
deviatoric stress tensor in (3.14), the equation becomes:

ρ
Dv

Dt
= −∇p+ µ

(
∇(∇ · v) +∇2v

)
+ f (3.15)
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However, from continuity (3.6) we know that ∇ · v = 0; therefore, we are left with:

ρ
Dv

Dt
= −∇p+ µ∇2v + f (3.16)

If we expand the material derivative with respect to velocity, we are left with the common form of
the incompressible Navier-Stokes equations. In (3.17) the different terms are labeled with respect
to their physical meaning.

Inertia (per volume)︷ ︸︸ ︷
ρ
( ∂v

∂t︸︷︷︸
Unsteady

acceleration

+ v · ∇v︸ ︷︷ ︸
Convective
acceleration

)
=

Divergence of stress︷ ︸︸ ︷
−∇p︸ ︷︷ ︸

Pressure
gradient

+ µ∇2v︸ ︷︷ ︸
Viscosity

+ f︸︷︷︸
Other
body
forces

. (3.17)

It should be noted that despite the rather short form of (3.17), this is a representation of three
distinct non-linear PDEs (for 3D Cartesian coordinates). Many assumptions must be made to
obtain an incompressible fluid, and simplifications have been made. Even in their reduced form,
the incompressible fluids case is still not trivial to solve. (3.17) can be expressed in many different
coordinate systems. The most common is in Cartesian form. This system is shown below in (3.18)
[5].

ρ

(
∂u

∂t
+ u

∂u

∂x
+ v

∂u

∂y
+ w

∂u

∂z

)
= −∂p

∂x
+ µ

(
∂2u

∂x2
+
∂2u

∂y2
+
∂2u

∂z2

)
+ ρgx

ρ

(
∂v

∂t
+ u

∂v

∂x
+ v

∂v

∂y
+ w

∂v

∂z

)
= −∂p

∂y
+ µ

(
∂2v

∂x2
+
∂2v

∂y2
+
∂2v

∂z2

)
+ ρgy

ρ

(
∂w

∂t
+ u

∂w

∂x
+ v

∂w

∂y
+ w

∂w

∂z

)
= −∂p

∂z
+ µ

(
∂2w

∂x2
+
∂2w

∂y2
+
∂2w

∂z2

)
+ ρgz

(3.18)

Along with the continuity equation in (3.6), the three equations in (3.18) create a complete math-
ematical system governing incompressible flow. The solution of these equations is not trivial nor
obvious. While the incompressible cases can be reduced to more specific cases that can be solved
analytically (see Section 5), it is evident that a generalized solution method is needed to solve
complex flow profiles. For CFD this method is called the finite volume method. This method as
well as other solution methods are outlined in Section 3.3.

3.3 Overview of Solution Methods

3.3.1 Finite Difference Method

The finite difference method (FDM) was among the first methods applied to the approximation
of PDEs [4]. It was first utilized by Euler around 1768. The concept of the FD method is to
approximate the solution of each point and its derivatives. This is done through the expansion
of the dependent variable about a point through Taylor series. For an example let’s consider the
simple PDE of

∂φ

∂x
= 0 (3.19)

To solve the PDE (3.19), we must have an approximation of the first derivative of φ. This can be
done through Taylor series expansion about a grid point xi by:
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φ(x) = φ(xi) + ∆x

(
∂φ

∂x

)
i

+
∆x2

2

(
∂2φ

∂x2

)
i

+ ... (3.20)

By neglecting terms higher than first order in (3.20) we can solve for the first derivative of φ:

∂φ

∂x
=
φ(xi + ∆x)− φ(xi)

∆x
+O(∆x) (3.21)

where O(∆x) is an indication of the truncation error. The same procedure can be applied to derive
more accurate derivatives as well as higher order derivations if (3.19) had called for them. There
are also three different schemes to take the Taylor series expansion: forward difference method,
central difference method, and backward difference method. The equation shown in (3.21) employs
a forward difference routine.

A finite difference approximation then provides an algebraic system at each grid point node (re-
gardless of space dimension) [2]. This equation can be linear or non-linear depending on the PDE
being solved. For the example shown in (3.19), only linear terms would be necessary. This system
of equations can be written in matrix form as

Aφ = Q (3.22)

The equation (3.22) can then be solved for the unknowns in φ to obtain a solution for the PDE
(3.19). This is done through application of known boundary conditions and employing a matrix
solving scheme to obtain a solution.

An important advantage to the FD method is its simplicity [4]; however, the finite difference method
has its disadvantages. The FD method cannot be directly applied to curvilinear coordinates [4];
instead, the equations must be converted to a Cartesian coordinate system. Today the FD method
is only very rarely used for industrial applications.

3.3.2 Finite Element Method (FEM)

The finite element method was originally employed solely to perform structural analysis [4]. The
original FEM codes arose from the need for deformation and stress prediction within the confines
of the theory of linear elasticity. From this limited initial scope, FEM codes have grown alongside
increasing computational power. In the early 90’s the finite element method began to be applied
to the solution of the Navier-Stokes equations [8]. The finite element method has a very rigorous
mathematical foundation and research into its potential applications with regards to fluids appli-
cations continues [4].

The mathematics behind the finite element method can be summarized by several steps [9]:

1. Discretization

2. Local or Elemental Approximation

3. Integral Forms and Algebraic Systems: Elemental Equations

4. Assembly of Elemental Solutions

5. Computation of the Solution

6. Post-Processing
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There are also various methods of approximation based on integral forms or the integral form of
the variation of the residual functional. Each one of these forms creates a different method which
fits into the computational framework of the finite element method. These include [9]:

1. Galerkin Method

2. Petrov Galerkin Method

3. Weighted Residual Method

4. Galerkin Method with Weak Form

5. Least Squares Method

There are too many details associated with the finite element method for its full presentation within
this tutorial. However, there are numerous published works with regards to the subject. These can
be be found with applications to fluid dynamics in references [8] and [9].

3.3.3 Finite Volume Method (FVM)

The finite volume method utilizes the integral form of the conservation laws (Navier-Stokes equa-
tions) [4]. This is done by separating a computational domain into a series of finite arbitrary control
volumes. Two types of cell schemes are generally considered [4]:

1. Cell-centered scheme - flow quantities are stored at the center of each cell.

2. Cell-vertex scheme - flow quantities are stored at the grid point of the cells.

The finite volume method is carried out directly in physical space, i.e., there is no change of co-
ordinate systems nor use of a jacobian of transformation. This can be both advantageous and
disadvantageous, depending upon the situation.

Let’s consider the incompressible continuity equation as a representation of how the FVM works.
From (3.6) we know

∇ · v = 0 (3.23)

represents the continuity equation of an incompressible flow. Converting (3.23) into an integral
form over a control volume ∫

Vi

∇ · v dV = 0 (3.24)

and applying the divergence theorem, we obtain (where η is a unit normal):∮
Si

v · η dS = 0 (3.25)

Now we have obtained a boundary integral describing the continuity of an arbitrary control volume
Vi. To proceed further the finite volume method approximations of this surface integral would be
required on a cell-by-cell basis. This is done by using suitable quadrature formulae [2], which is
outside the scope of this tutorial and will not be shown. Approximations are introduced for volume
integrals as well, these would occur in equations other than (3.25) as well. As a result, a system
of algebraic equations is obtained for each control volume, in which the centroids to its neighbors
also appear [2].
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Unlike other methods, the FVM can accommodate any type of grid shape. The grid defines only
the bounds of each control volume and thus, controls how the system of equations is derived for
each problem. The allowance of any grid shape allows the FVM to easily accommodate complex
geometries [2]. The allowance of arbitrary grid shapes also allows for rapid discretization of the
computational domain using automeshing techniques. These reasons among others is why the finite
volume method has become so popular in the CFD industry today.

4 The CFD Modeling Process

The following steps should be completed for every CFD analysis conducted. While the steps are
presented as a sequential series of tasks, there will be some overlap as the modeling efforts become
more complex.

• Understand the physics

• Define the computational volume

• Create the computational grid

• Select the model physics

• Apply the model boundary conditions

• Initialize the solution

• Solve

We will use an example to illustrate these steps.

4.1 Example 1: Mixing Tank

Consider the paddle mixer shown below in Figure 4.1.

Figure 4.1: Paddle Mixer Detailed Geometry
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The mixer has a 6’ ID and is flooded with 3’ of fluid (to the top of the model displayed). As can
be seen from the image the mixer is a paddle type with three blades, and has a swept diameter of
50”. The blades rotate at 50 rpm. There are three fluid inlets, two water inlets and one carbon
tetrachloride inlet. The inlet piping has a 3.75” ID. The water enters with a flow rate of 1,355.31
gpm and the carbon tetrachloride enters with a flow rate of 225.88 gpm.

The primary purpose of the analysis is to estimate the mixing efficiency. We will be using some
advanced models for this analysis. For now, do not concern yourself too much with implementation
of the CFD physics; instead, follow the workflow required to complete the analysis.

4.2 Understand the Physics

Despite the complexities involved in performing CFD analyses, as the first step in any analysis
calculations should be performed using empirical information. You MUST understand the physics
of the problem before you can make informed selections on the variety of individual details that
will be required for a successful analysis. Based on the problem under consideration, any number
of variables may be calculated. As examples:

• Expected bulk velocities / Mach number

• Expected flow Reynolds number

• Expected boundary layer thickness

• Expected bulk heat transfer

As a hint, during this time you will be calculating flow related variables and may also be calculat-
ing thermodynamic quantities. It is suggested that calculations are performed in SI units to avoid
problems with consistent units inherent in these types of calculations when using Imperial or US
Customary units. Also, you will likely be revisiting these calculations, and possibly performing
“what-if” scenarios. Therefore, it is advised that you create electronic copies (MathCad, Excel,
etc.).

For our problem, at a minimum we should calculate the mixer’s Reynolds number, the expected
concentrations at the outlet and the inlet velocities.

For a mixer [10]:

Re =
ρD2N

µ
(4.1)

Where:

• D Mixer diameter, 50” (1.27 m)

• N - Mixer Speed

The following table contains the fluid properties for the mixture’s components.

Table 4.1: Mixer Fluid Properties

Fluid Density (kg/m3) Dynamic Viscosity (Pa-s)

H2O 997.561 8.8871 x 10−4

CCl4 1582.63 9.11717 x 10−4
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Mixture fluid properties are calculated on a volume basis, or:

Pc =

n∑
i=1

ViPi

n∑
i=1

Vi

(4.2)

Where:

• Pc - Combined property value

• Vi - Volume of individual component

• Pi - Property for individual component

In this case, the combined fluid density is 1,143.8 kg
m3 and the combined viscosity is 8.94 x 10−4

Pa-s. Using this information, compute the Reynolds number, 1.03 x 108. In this case it can be
assumed that the flow will be turbulent.

Simple inspection indicates that for a perfectly mixed tank the concentration of water at the outlet
should be 75%.

To determine the inlet velocities, first we must calculate the inlet area 11.04 in2 (7.126 x 10-3 m2).
Next convert the flow rates to the proper units (this is performed on a per inlet basis for the water).

Table 4.2: Fluid Properties

Fluid Flow Rate (in3/s) Flow Rate (m3/s)

H2O 1,304.50 2.1377 x 10−2

CCl4 869.7 1.4251 x 10−2

The inlet velocities can then be calculated.

Table 4.3: Inlet Velocities

Fluid Inlet Velocity (m/s)

H2O 3
CCl4 2

4.3 Define Computational Volume

Volumes, commonly referred to as domains or regions, should include all features required for the
study at hand. Features will be classified as:

• Relevant flow features: All major flow features should be included for the analysis. This
includes large geometric features such as steps or flow obstructions.

• Features that don’t affect the flow under consideration: Typically, small flow features will
not be included, especially for initial analyses. Examples of this would be rivet heads for an
aerodynamic analysis or spray nozzles that may be replaced by injector features.
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In CFD a fluid volume must be created. This volume typically will fill the void bounded by the
geometry domains. Typically, the initial computational volume will be created in a CAD package
and transferred for construction of the computational grid. The representations will require unique
surfaces for each boundary condition that will be applied to the model. Individual steps involved
in creating the volumes will be software specific.

For the paddle mixer below, the computational volume should include the volume of fluid within
the vessel, the mixing blades and the drive shaft. The volume should not include any small features
nuts and bolts, etc. Depending on the mixing energy under consideration, the volume may need to
include gas space above the mixer to track the free surface. For the initial analysis we will assume
that the free surface can be adequately represented by a slip-wall boundary condition.

In this case the mixer geometry was supplied in an as-built configuration that included mounting
brackets, detailed hub geometry and fasteners. As the first step, these model components should
be simplified or removed, as shown below.

Figure 4.2: Simplified Mixer Geometry

For simplification, the impeller hub was modified by removing all mounting details and fasteners,
leaving a cylindrical volume with which the impellers intersect. The brackets and bolts associated
with the side baffles were removed from the model. As the baffles are sheet metal, their thickness
will not be included in the final model. Instead they will be represented by 2-dimensional baffle
boundary conditions. Some CFD packages offer the capability in the pre-processor to collapse thin
wall structures into planar surfaces that intersect the volume. We will assume that this function-
ality is not available.

First we will create the total fluid volume:
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Figure 4.3: Initial Mixer Computational Volume

Next we will core out the shaft, hub, and impeller geometry.

Figure 4.4: Computational Volume with Shaft, Hub and Impeller Removed

For this problem we are not concerned with flow details near the model inlets and outlet. Further,
we are unconcerned with the velocity distribution as the fluids enter the vessel. These simplifying
assumptions allow us to split the external surfaces to provide boundaries that we can act on in the
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CFD software.

Figure 4.5: Computational Volume Split to Provide Inlet and Outlet Boundary Surfaces

To allow the creation of the 2D baffles the initial computational volume will be split into four
volumes. This will consist of a central core surrounded by three 120◦ wedges. Internal interface
boundary conditions will be applied between the central core and each wedge. Baffle interface
boundary conditions will then be applied between each wedge.
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Figure 4.6: Initial Computational Volume Subdivided into Four Volumes

4.4 Create the Computational Grid

Each of the computational volumes requires discretization for solution. Grids can be described as
structured, unstructured, and hybrid meshes, as defined below:

• Structured grids have regular connectivity characterized with quadrilaterals in 2D and hexa-
hedra in 3D. The regular connectivity of the mesh allows minimization of the storage arrays
required for solution.

• Unstructured grids do not display regular connectivity. This allows for the use of a wider
variety of element shapes including, tetrahedral, wedges, and polyhedral cells.

• Hybrid grids contain portions of structured grids and unstructured grids. This allows for
minimization of storage requirements for areas of the computational volume that can be
meshed with a structured grid, while allowing the inclusion of complex geometric features in
the computational volume.

Generally, with most current commercial CFD solvers, conformal grids are not required. Some
academic-level solvers require structured grids, while most commercial-level solvers allow unstruc-
tured and hybrid grid topologies. Most commercial solvers also allow for the use of tetrahedral,
polyhedral and trimmed cell mesh topologies, as described below:

• Tetrahedral – Tetrahedral topologies contain 4 triangular faces bounding a tetrahedral volume
(exact analogue to finite element topologies). As with FE methodologies, tetrahedral grids
are likely to produce the most inaccurate results.

• Polyhedral – Polyhedral topologies are developed by combining multiple tetrahedra to form
a polyhedral volume. From a solution standpoint, they offer significant advantages over
tetrahedra [11]. For a number of cases polyhedra are becoming the default mesh topology, due
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to the solution advantages and the ability to generate conformal interfaces using automeshers.
It should be noted that creating significantly biased mesh topologies, as is sometimes required
to minimize model size, can require extensive user interaction.

• Trimmed – Trimmed cell topologies are primarily constructed from a core hexahedral grid
that is then trimmed in the local boundary surface region to represent the model’s geometry.
Trimmed grids offer the advantage of consisting of a predominately hexahedral mesh with
minimal cell skewness and the ability to align the mesh with user-specified coordinate systems.

Figure 4.7: Example Mesh

Grids can be created using automeshers, or purpose-built meshers, such as:

• Gambit

• Pro-Star

• Hypermesh

• Gridgen

For a more exhaustive list of available grid generation packages, including open source and com-
mercial packages (with descriptions), see [12].

As shown throughout this tutorial, the selection of mesh topology can significantly affect the cal-
culated results. For this reason, generation of appropriate computational grids is considered an art
form that relies on past experience and the analyst’s understanding of the flow physics with careful
solution tracking to ensure a proper final solution. In other words, there is no general governing
set of rules for the creation of computational grids.

For the mixer example we will create an auto-mesh generated trimmed cell mesh. We will employ
near wall prism layers, with the default values and select a mesh size of 0.5”. Note that this mesh
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size was chosen for model size, not based on the physics of the problem. In subsequent steps we
will refine the mesh based on the solution. The initial model contains 590,588 computational cells,
as shown below.

Figure 4.8: Mixer Grid

4.5 Select Physics

The choice of physics models selected will determine what quantities are solved for during the so-
lution. Physics will need to be defined for each computational volume or domain within the model.
For all domains under consideration, several choices involving the physics will need to be made.
These include:

• Volume space representation (2D or 3D)

• Volume time representation (steady-state or transient)

• Volume material representation (gas, liquid, solid or other)

• Solution method (coupled or segregated)

• Equation of state (constant density, ideal gas, IAPWS-IF97, other)

• Turbulent considerations for fluid regions

• Additional physics

For the mixer under consideration, we will need to include the following physics:

• Volume space representation - 3D

• Volume time representation - Steady-state
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• Volume material representation - Non-reacting, multi-component liquid

• Solution method - Segregated

• Equation of state - Constant density

• Turbulence - Realizable two-layer all y+ k − ε

4.6 Apply Boundary Conditions

Each surface that was created has to have a boundary condition associated with it. By default
CFD packages will assign a wall boundary condition to each surface. In general there are 8 types
of CFD boundary conditions, as described below [13, 14]:

• Outlet Boundary - Outlet boundary conditions assume zero normal gradient relative to the
face (except for pressure) and are typically used to represent the outlet of a duct. They are
useful when pressure and velocity distributions and values are not known for the problem un-
der consideration. It should be noted that outlet boundary conditions do not enable pressure
control for the problem; therefore, if maintaining system pressures are critical (i.e., ideal gas)
another boundary condition should be used. At a minimum the amount of flow exiting the
outlet will be specified for the boundary condition.

• Pressure Boundary - Pressure boundaries allow the specification of the static pressure at the
boundary; therefore, they should be used when pressure control must be maintained for the
model. At a minimum, the static pressure at the outlet will be specified.

• Mass Flow Inlet - The mass flow inlet should be used for internal, compressible flows where
the inlet mass flow rate is known. When this boundary condition is used, a pressure outlet
boundary condition should be used at the model outlet. At a minimum the flow direction, the
mass flow rate, the supersonic static pressure and the total temperature must be specified.

• Free-Stream - Free-stream boundary conditions represent the far field fluid properties for
external flow simulations and are typically used for aerodynamics. The ideal gas model must
be activated and the boundary condition is not suitable for internal flows. At a minimum,
the flow direction, Mach number, static pressure and static temperature will be specified for
a free-stream boundary condition.

• Stagnation Inlet - The stagnation inlet boundary condition serves as a pressure inlet boundary
condition for compressible and incompressible flows. At a minimum, the flow direction and
total pressure will be specified. For compressible flows, the supersonic static pressure, total
pressure and total temperature will be specified.

• Velocity Inlet - Velocity inlets allow the specification of the velocity at the inlet. At a minimum
the flow direction and velocity magnitude will be specified at the inlet.

• Wall - Specifies a wall, typically with a no-slip boundary condition. The model can be modified
to allow for tangential motions (slip-wall). At a minimum, no additional information needs
to be supplied for a wall boundary condition. With more advanced physics, wall parameters
can be applied to walls, such as:

– Energy - Heat flux, temperature or convection

– Turbulence - Wall roughness or shear stress can be assigned to the wall

– Motion - Translational and rotational motions can be specified

• Symmetry - Symmetry boundary conditions are similar to slip-walls with the addition of
enforcing zero normal gradients of all flow variables and zero normal velocity.
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It should be noted that the boundary condition inputs listed above are the minimums that must
be defined. In most cases additional inputs will be required based on the physics models that are
selected for the solution (turbulence, energy, etc.). It should also be noted that most commercial
CFD packages allow the specification of boundary conditions that vary with spatial coordinate.
This can be accomplished through either table data or through mathematical formulations.

Additional sources of boundary conditions are interface sets. Interface sets are a method of connect-
ing one computational volume to another, or to interface two boundaries on the same computational
volume with periodic or repeating boundary conditions.

Interfaces between computational volumes with the same computational physics can have the fol-
lowing properties:

• Internal - Internal interfaces transfer solution variables from one volume to another without
modification.

• Baffle - Baffle interfaces behave as a 2-dimesional wall.

• Fan - Fan interfaces allow specification of velocity, flow rate or pressure jump based on input
fan curve information.

• Fully Developed - Fully developed interfaces allow the specification of either mass flow or
pressure jump across the interface.

• Porous Baffle - Porous baffles allow flow between volumes with an associated pressure loss
based on velocity.

Contact interfaces are used to connect computational volumes with dissimilar computational physics
models. Contact interfaces allow the specification of a thermal resistance (to model contact resis-
tances) and the specification of heat fluxes at the interface.

For the mixer the following boundary conditions will be defined.

• H2O inlets - Velocity inlet, velocity and species fraction

• CCl4 inlet - Velocity inlet, velocity and species fraction

• Outlet - Flow split outlet, flow split

• Internal volume to external volumes - Internal interface

• External volume to external volume - Baffle interface

4.7 Initialize Model

Model initialization involves allocating memory for all variables that will be stored during the
solution, then defining initial values for those variables. As the CFD solution process involves
the iterative solution of non-linear equations, proper application of initial conditions can signif-
icantly affect the number of computational cycles required to converge the solution. Estimates
may be made for the initial conditions based on the initial empirical calculations performed for the
problem; past experience with similar models; or on previous coarse models of the computational
domains. Initial conditions can be defined for physics continua or on a computational volume-by-
volume basis. Additionally, the initial conditions can have spatial variance defined through either
tabular data or through mathematical functions.
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It is generally good practice to create contour plots to validate that the initial conditions have
been applied correctly to the model. For almost all analyses, a minimum of velocity and pressure
contour plots should be created. Depending on the selected model physics, additional plots may
be warranted. Each detailed example in this tutorial contains a discussion related to the selection
of initial conditions for the model.

We do not know, a priori, what the velocity distributions are within the mixer. It is known that
there will be swirl in the flow, but the exact magnitude and distribution of this swirl is not known.
In this case it is likely better to initialize the flow with a zero velocity and allow the software to
determine the distribution. It is expected for this case that variations in the pressure distribu-
tions within the mixer will be minimal and that the majority of the variance will be based on flow
velocity. For this reason, a zero pressure distribution through the mixer is appropriate. As the
purpose of this analysis is to determine the mixer’s efficiency, it is good practice to initialize the so-
lution in an unmixed case. For this case we will assign a 100% water mass fraction within the vessel.

We will set these conditions in the physics continuum, initial conditions section. Before initializa-
tion, we will establish two contour plots to verify the proper application of the initial conditions:

• Velocity

• Water mass fraction

Figure 4.9: Initial Velocity Profile

33 of 110



USE OF CFD IN DESIGN 4 THE CFD MODELING PROCESS

Figure 4.10: Initial Species Mass Fraction

4.8 Solve

As the Navier-Stokes equations are nonlinear, solving them requires an iterative solution method-
ology. At a minimum, all CFD solvers will provide feedback through solution residuals. Residuals
measure the change in a flow variable - continuity, momentum, energy, turbulence, etc. - per iter-
ation. It is industry standard that the residuals should decrease by at least 3 orders of magnitude
during solution.

In addition to monitoring the solution residuals it is common to establish additional measures
within the model to track the solution’s progress. Examples of such monitors are:

• ∆P

• Maximum solution values

• Mean solution values

Plots will typically be created that allow tracking of solution monitors on a per iteration or per
time-step basis. During the solution process the contour plots established to validate the proper
application of model initial conditions should continue to be monitored. These plots will provide
the best feedback on the proper application of boundary conditions and locations in the model
where solution divergence may be occurring.

CFD solvers provide a direct control for the solution implemented using-relaxation factors. Relax-
ation factors control the factor of the difference between the current and previous step’s solution
values. These can be applied to determine the current solution value. Reducing these factors results
in a decrease in the update rate and can be helpful if the solution is undergoing oscillatory behavior.
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Increasing the factors on a well behaved model can decrease the total number of iterations required
to achieve convergence. Generally, large modifications to the solution under-relaxation factors are
considered to be expert use of the software.

Two additional monitors will first be created to track solution convergence for the mixer:

• Average outlet mass fraction per iteration

• Wall shear stress on blades, hub and shaft - this plot will be used to ensure proper application
of the rotating wall boundary conditions.

We will allow the solution to proceed for 50 iterations, then check the wall shear plot to ensure
proper application of the boundary conditions. It should be noted that the solution should be al-
lowed to proceed for several iterations before boundary condition checks are performed; depending
on the initial and boundary conditions selected for the model, misleading feedback may occur in
a few iterations. Figure 4.11 shows that the wall motion boundary conditions were applied correctly.

Figure 4.11: Paddle Blade Wall Shear at 50 Iterations
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Figure 4.12: Solution Residuals for Initial Mixer Model

After the rotation of the mixer blades has been verified, we allow the solution to proceed until little
to no change in the solution residuals is evident.

As can be seen from the residual plot Figure 4.12, for the most part the residuals are invariant. Also
evident from the plot is that the residuals for turbulent dissipation rate and CCl4 concentration
have not reduced by an order of magnitude. For additional solution feedback, we also inspect the
outlet mass fraction plot Figure 4.13.
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Figure 4.13: Outlet Mass Fraction Plot for Initial Mixer

The outlet mass fraction plot indicates that there is little to no change in calculated mass fraction
per iteration. As convergence difficulties were encountered with the turbulence model, the grid
may need refinement in the near wall area. To accomplish this we create two cylindrical volume
source terms in the inner domain, one encompassing the paddles and one encompassing the shaft,
as shown in Figure 4.14.
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Figure 4.14: Refinement Volumes Selected for Mixer Model

Controls are established to cause the automesher to use a smaller base grid size and to add addi-
tional boundary layer prisms to the model. The new model contains 2,223,578 computational cells,
as shown in Figure 4.15.

Figure 4.15: Refined Mixer Grid

The solution is reconverged and the residuals and outlet mass fraction are evaluated, as shown in
Figure 4.16 and Figure 4.17.
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Figure 4.16: Reconverged Solution Residuals
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Figure 4.17: Reconverged Outlet Mass Fraction
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Inspection of the residual plot indicates that turbulent dissipation has not been reduced by 3 orders
of magnitude. Inspection of the outlet mass fraction indicates that the calculated mass fraction
was not significantly affected by the mesh refinement step. In this case, if a designer was comparing
variants, the solution has probably reached an acceptable level of convergence. It should be noted
that other variants should be analyzed using the same methodology. If the results of the analysis
were going to be used for quantitative evaluation of the mixer’s performance without physical
testing, further model refinements would be warranted.

5 Example 2: Flow Between Parallel Plates

What’s in this Example?

Basic Setup
The basic model setup is shown including importing a mesh, applying
physics, setting boundary conditions as well computing a solution.

Proper
Initialization

Proper initialization of a model is shown to bring about a quicker
solution to the model problem.

Grid Sensitivity
The concept of grid sensitivity is explored by showing several different
meshes. This is sometimes called grid or mesh convergence.

Effective
Computational

Volume

Proper selection of the computational volume is shown within this
example through emphasis of modeling an infinite domain.

x

y
h

h

u

umax

Figure 5.1: Flow Between Parallel Plates

One of the simplest textbook cases for fluid dynamics is the flow between parallel plates. This is
a simplified case of Couette flow in which neither the top nor bottom plate is moving. Consider
the two infinite parallel plates shown in Figure 5.1. In this case all fluid particles are moving in
the x direction fully parallel to the plates,( i.e., there is no flow in the y direction). Through the
reduction of the Navier-Stokes equations (derivation not shown), the velocity profile is [5]:

u =
1

2µ

(
∂p

∂x

)
(y2 − h2) (5.1)

Where:

• µ = dynamic viscosity
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• ∂p
∂x = pressure gradient in the x direction

• h = the height defined in Figure 5.1

• y = the y location defined in Figure 5.1

Thus it can also be shown that the maximum velocity of the flow occurs in the geometric center
(y = 0) labeled as umax. umax can be shown to be:

umax = −h
2

2µ

(
∂p

∂x

)
(5.2)

5.1 Understand the Physics

From the problem statement we know that the flow between the parallel plates will be steady,
laminar flow. Since this is flow between parallel plates and there is no effect of a third dimension,
we will model this problem in 2D-space. We also have a theoretical solution of the velocity pro-
file given in (5.1). Thus, we have an indication of if our CFD model has obtained the proper solution.

For the sake of modeling the problem, assume that we are given the following values:

• The width of the parallel plates is 0.02m (h = 0.01m)

• The fluid in question is water operating at 25◦C

– µ = 1.002E−3 [5]

– ρ = 998.2 kg
m3 [5]

• While these are infinite plates, they will be modeled with a length of 5 m

• The pressure drop between the left and right is 1 Pa
m ( ∂p∂x = −1 Pa

m )

We must also check the validity of our model assumptions. The laminar model for parallel plates
is only valid for laminar flow, thus if our selected values place the problem in the turbulent region,
then the solution will not be valid. For the parallel plates problem, the flow will be laminar if the
Reynolds number is less than 1400 [5]. We can calculate the Reynolds number of our flow (specific
to the parallel plates case) as:

Re =
2ρh3

3µ2

(
∂p

∂x

)
= 662.81 (5.3)

Thus the Reynolds number is less than 1400 and the model case is valid for laminar flow. If we use
(5.2) we can calculate the maximum velocity in the plates to be:

umax = − (0.01)2

2(1.002E − 3)
(−1) = 0.0499

m

s
(5.4)

5.2 Define Computational Volume

Despite the fact that we are attempting to model an infinite domain, we will model the length of
the parallel plates as 5 m. With the given values assumptions in Section 5, the total height of the
2D volume is 0.02 meters. Thus, our computational volume will be a 2D rectangle as shown in
Figure 5.2 (not to scale).
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5 m

0.02 m

Figure 5.2: 2D Computational Volume

5.3 Create a Computational Grid

For this example consider the creation of several 2D grids. These can be shown in Figure 5.3. As
seen in Figure 5.3, grid refinement techniques are successively implemented. For the solution of
this problem we will experiment with the solution through grid refinement (sometimes referred to
as grid or mesh convergence).

(a) 150 Elements

(b) 1, 500 Elements

(c) 25,000 Elements

Figure 5.3: Various Mesh Refinement - 0.2 m of 2 m Mesh

For the initial study we will start with a mesh with 150 cells, shown in Figure 5.4a. As the study
progresses we will implement the more refined grids to determine their effect on the calculated
velocity profiles. During the presentation we will now switch to Star-CCM+ to import the first
grid for the analysis. The commands associated with the grid import are shown below.

Star-CCM+ Commands

1. File →New Simulation →OK

2. File →Import Volume Mesh →ex1-mesha.ccm

5.4 Select Physics

The selection of the physics requires several assumptions. This example problem is relatively simple.
Other problems with more exotic physics may require a higher understanding of the physics to
provide proper justification. In this case, we can assume that the flow patterns do not evolve in
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time; thus, a steady-state solver can be used. Because the velocities we are anticipating are also
low, we can decouple the relationship between velocity and pressure and use a segregated flow
solver. This will lower the solution time. As we are dealing with incompressible flow, the density
within the volume is can be assumed constant. As shown through the calculation of the Reynolds
number in (5.3), the flow is laminar, thus turbulence models do not need to be implemented. The
properties of the fluid must also be defined. These were given within the problem statement in
the previous section. The commands associated with selecting the appropriate physics models are
shown below.

Star-CCM+ Commands

1. Continua

→ Physics 1 (Right Click)

→ Select Models

→ Steady

→ Liquid

→ Segregated Flow

→ Constant Density

→ Laminar

→ Close

→ Models

→ Liguid

→ H20

→ Density

→ Constant: Set to 998.2 kg
m3

→ Dynamic Viscosity

→ Constant: Set to 0.001002 Pa · s

5.5 Apply Boundary Conditions

The momentum source term defined by the problem statement is the pressure drop between the
two endpoints, with a value of 1Pa

m . As our domain has a length of 5 m, the left end must have a
pressure 5 Pa higher then the right end. Thus we can set up two pressure boundary conditions:
5 Pa at the left end, and 0 Pa to the right end. This will simulate a pressure drop of 1Pa

m . The
command set below shows the application of this boundary condition set to the model.
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Star-CCM+ Commands

1. Regions

→ fluid 2D

→ Boundaries

→ outlet pressureoutlet (Double Click)

→ Type: Change to Pressure Outlet

→ inlet pressureinlet (Double Click)

→ Type: Change to Pressure Outlet

→ Physics Values

→ Pressure

→ Constant: Change to 5 Pa

5.6 Initialize Model

Initialization of the model can affect the solution time for any given problem. Initializing the model
closer to the converged solution will result in a drastic reduction of the solution of the non-linear
PDEs of the Navier-Stokes equations. During the first solution, no variant initial conditions will be
defined. In the second solution, an educated guess with regards to the pressure distribution will be
defined. Without implementing with any initial conditions for pressure and velocity, both values
will take on their defaults: in this case values of 0 at all points.

It is also necessary to set up ways to monitor the development of the solution. This is done in Star-
CCM+ through the creation of “Scenes”. Similar actions can be taken in other software packages.
The “Scenes” allow the analyst to visualize the solution during each iteration until convergence is
achieved. X-Y plots, contour plots, and other visual interpretations can also provide the analyst
with useful feedback about the solution in the current iteration. This information combined with
information on solution residuals can help produce a better solution.

44 of 110



USE OF CFD IN DESIGN 5 EXAMPLE 2: FLOW BETWEEN PARALLEL PLATES

Star-CCM+ Commands

1. Scenes (Right Click)

→ Scalar (Perform 2 times)

2. Scenes

→ Scalar Scene 1 (Right Click)

→ Rename: Velocity Scene

→ Scalar Scene 2 (Right Click)

→ Rename: Pressure Scene

→ Velocity Scene

→ Displayers

→ Scalar Field (Right Click)

→ Edit

→ Function

→ Velocity i

→ Pressure Scene

→ Displayers

→ Scalar Field (Right Click)

→ Edit

→ Function

→ Pressure

3. Plots (Right Click)

→ Newplot →X-Y

4. Plots

→ X-Y Plot 1 (Right Click)

→ Rename: Velocity Profile

→ Velocity Profile

→ Parts

→ outlet pressureoutlet

→ X-Type

→ Position

→ Direction: [0.0, 1.0, 0.0]

→ Y-Types

→ Y-Type 1

→ Scalar: Velocity i

5. Solution →Initialize Solution
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5.7 Solve

To solve this problem we will approach the solution in four manners:

1. Using Mesh A from Figure 5.4a without initial conditions

2. Using Mesh A from Figure 5.4a with initial pressure conditions

3. Using Mesh B from Figure 5.4b with initial pressure conditions

4. Using Mesh C from Figure 5.3c with initial pressure conditions

First, solve the problem set up with Mesh A and without any initial conditions. After achieving a
converged solution for the problem the static pressure and velocity profile shown in Figure 5.4.

(a) Pressure

(b) Velocity

Figure 5.4: Results of Pressure and Velocity from Mesh A

Star-CCM+ Commands

1. Solution →Run

Now, we’ll rerun the problem with a pressure distribution defined for an initial condition. It is a
safe assumption to say that the pressure varies linearly between both ends. A function (or a “field
function” in Star CCM+) can be defined to represent this pressure variation. After performing
another solution, the model converges to the same solution obtained in Figure 5.4.
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Star-CCM+ Commands

1. Tools

→ Field Functions (Right Click) →New

→ User Field Function 1 (Right Click)

→ Rename: initial pressure

→ initial pressure

→ Definition: 5-1*$Position 0

→ Function Name: initial pressure

2. Continua

→ Physics 1

→ Initial Condition

→ Pressure (Double Click)

→ Method: Field Function

→ Field Function →Scalar →initial pressure

If the model converges to the same solution with and without the pressure function, what’s the
point of adding an initial condition? Since this is such a small computational model it has saved
very little time. However, if we view a graph of minimum and maximum pressure within the model
throughout iterations, the reasoning for introducing a proper initial condition is clear. By observing
Figure 5.5 and Figure 5.6 on page 48 the difference between introducing an initial condition and not
introducing one is astounding. In Figure 5.5 the minimum and maximum pressures vary by orders
of magnitude during solution. Since CFD is an iterative method, this can occur. However, after
nearly 80 iterations, the solution has returned and is converging towards the true solution values.
In contrast, in Figure 5.6 the pressure traces demonstrate a solution close to the true solution; thus
a converged solution is achieved with fewer iterations.

This is a small model and the additional 80 iterations represents a negligible amount of computa-
tion time. In a larger model, however, this may not always be the case. The computational effort
could increase by orders of magnitude especially if the initial conditions are not a proper estimate
of the solution.

Further, notice that the maximum velocity in Figure 5.4 is 0.051300 m
s . This is greater than the

theoretical maximum velocity given by (5.4) of 0.499 m
s . In this case, while a “converged” solution

is indicated through the solution monitors, the model has not predicted the correct maximum ve-
locity. Closer inspection of the velocities at the outlet (as shown in Figure 5.7) indicates that the
solution is not a parabola but rather a triangle. This is likely caused by a lack of grid resolution
through the thickness.

Now we will use the more refined grids in an attempt to experience grid convergence. For the
first attempt at convergence, swap Mesh A with Mesh B for a higher grid resolution. As shown in
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Figure 5.5: Pressure Without Initial Conditions
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Figure 5.6: Pressure With Initial Conditions

Figure 5.3, Mesh B has an order of magnitude more elements than Mesh A. To refine the mesh in
the solution, we now only need to import the new gird and swap the new grid for the existing grid.
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Figure 5.7: Velocity Profile for Mesh A

Due to the nonlinear iterative solution process, as well as the methods used to store the solution’s
variables, a restart analysis can be performed on the refined model. This is uniquely different
than the processes associated with most FE solution methods. As the solution has been previously
converged to values approaching the theoretical solution, the number of iterations required to re-
converge the solution with the refined grid will be low. This is because the new solution’s initial
conditions already approach the theoretical solution. The commands below demonstrate how the
new grid is imported and swapped for the original grid.

Star-CCM+ Commands

1. File →Import Volume Mesh →ex1-meshb.ccm

2. Regions

→ fluid 2D (Right Click)

→ Replace Mesh

→ Replace Mesh in fluid 2D with mesh from fluid b

3. Solution →Run

It should be noted that after the solution is restarted, the residuals will rise. This is due to the
fact that large changes in the flow variables can occur during the initial iterations due to the re-
fined grid’s ability to better capture the details in the flow. It is expected that the magnitude of
the residuals will begin to decrease after several iterations, indicating that convergence is restart-
ing. After the solution has converged with the refined grid, if the solution between one grid and
a more refined grid is the same (or within an acceptable error), then the solution is said to be
grid-independent. Grid independence or another grid convergence criterion is standard practice for
almost all academic and industry problems. The solution that we receive for velocity at the end of
the parallel plates is seen in Figure 5.8.

When Figure 5.7 and Figure 5.8 are compared, it can be stated that the solution has not yet
achieved grid independence. The solution has in fact changed with respect to grid density, which is
undesirable. We can repeat this same process for another grid with higher density. We will replace
Mesh B with Mesh C, as demonstrated below.
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Figure 5.8: Velocity Profile for Mesh B

Star-CCM+ Commands

1. File →Import Volume Mesh →ex1-meshc.ccm

2. Regions

→ fluid 2D (Right Click)

→ Replace Mesh

→ Replace Mesh in fluid 2D with mesh from fluid c

3. Solution →Run

After this process is complete and the solution is re-converged, the velocity profile seen in Figure 5.9
is predicted. The contours from the plot indicate that the solution has begun to take on the
parabolic shape associated with the theoretical solution. If the process was repeated with a new grid,
incorporating double the element density, the velocity profiles would indicate that the calculated
solution is approaching grid independence. However, it should be noted that the maximum velocity
is 0.047012 m

s , which remains different from the theoretical value of 0.499 m
s . The reason for this

difference will be discussed in the next section.

Figure 5.9: Velocity Profile for Mesh C
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5.8 Results

Through the use of proper initial conditions we have demonstrated that the speed of the solution
can be enhanced. The effects of grid sensitivity were also investigated and shown. Figure 5.7,
Figure 5.8, and Figure 5.9 graphically show the rate of mesh convergence in the velocity profile. If
another mesh were created at a higher density than Mesh C, it would also be apparent that the
solution is approaching grid independence. However, comparison to the theoretical solution can be
better seen in Figure 5.10. Here it is shown that as we continue to refine the grid, the velocity
profile better matches the theoretical shape.
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Figure 5.10: Velocity Profiles with Varying Grid Densities

When refinements in the grid density are implemented the shape of the solution better approaches
theoretical velocity profile, the maximum velocity decreases from the theoretical value, as shown
in shown in Figure 5.10. While this is the case, it is by coincidence that the lower mesh density is
closer to theoretical as this is not a grid-converged solution for Mesh A and Mesh B in Figure 5.10.
In this case, either an initial problem assumption was invalid, or CFD is not capable of producing
the theoretical solution.

Recall that the theoretical solution is for an infinitely long domain, which was originally modeled
using a 5 m length. While, in an engineering sense, 5 m is much greater than the 0.02 m height,
it was demonstrated in Figure 5.10 that we have not converged to the theoretical solution. This
is due to our domain approximation. By increasing the length of the computational domain, it
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is demonstrated in Figure 5.11 that the maximum velocity approaches the theoretical solution as
the domain length approaches infinity. In Figure 5.11 all domains were constructed using the same
discretization density of 5,000 elements per meter. If the computational domain could be modeled
as infinite, it is expected that the velocity profiles would be identical to theoretical. In this case,
the selection of an improper computational domain significantly affected the fidelity of the solution.

Figure 5.11 demonstrates that with a 1 m domain length maximum velocity is 0.033193 m
s or an

error greater than 30%. With this knowledge is should be obvious that the proper selection of
computational domains is critical to achieving accurate results.
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Figure 5.11: Domain Length vs Maximum Velocity

6 Introduction to Turbulence

6.1 What is Turbulence?

Start with a dictionary definition: “The haphazard secondary motion caused by eddies within a
moving fluid”.

Synonyms:

• Agitated

• Tumultuous
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• Violent

• Disordered

Using engineering terminology, turbulence is the spatial and time-varying components of a flow
field. Visually, it is often seen as eddies or vortices in the flow field. Turbulence exists in scales
ranging from molecular to atmospheric motions, as shown below.

(a) Vortex Structures Behind Passenger Aircraft (b) Atmospheric Turbulence on the
Sun

(c) Chemical Reactions Turbulence
at a Molecular Level)

Figure 6.1: Examples of Turbulence

Turbulence can be characterized by the following properties.

• Irregular

• Diffuse

• Rotational

• Dissipative

• Chaotic

• Cascading energies

– Integral

– Taylor microscales
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– Kolmogorov scales

Given the time and spatial variation of flow fields caused by turbulence it can be stated that tur-
bulent flows are not deterministic, rather they must be studied using statistical methods. Further,
by definition, the solution of a time-dependent, nonlinear equation set is dependent on the ini-
tial conditions and the time-dependent boundary conditions (i.e., the solution can display chaotic
behavior).

6.2 Can CFD Handle Turbulence?

Sure, the Navier-Stokes equations are almost perfect, all you have to do is modify them to include
a mean and time-varying component.

ρ

[
∂(Ui + ui)

∂t
+ (Uj + uj)

∂(Ui + ui)

∂xj

]
= −∂(P + p)

∂xi
+

(T
(v)
ij + τ

(v)
ij )

∂xj
(6.1)

Implementing these modified equations in a CFD solver is then simple. All you have to do is
construct a model with enough grid points so that the spacing is less than the Kolmogorov length
scale. The number of points required to resolve this is proportional to the Reynolds number raised
to the 2.25 power, in all three Euclidean directions.

N3 ≥ Re9/4 (6.2)

This massive grid then has to be analyzed with a time-step small enough that a fluid particle moves
less than the grid spacing for a time-step:

C =
u′δt

h
< 1 (6.3)

The analysis must then go through enough steps that all length scales (through the largest) are
resolved in the flow field, usually 10 - 100 times the time scales of interest. Note that this very
easily becomes millions of steps. While you’re performing this analysis, every boundary condition
must be exactly matched in time and space. Note that for data analysis you will need to output
flow quantities of interest at each time-step for statistical analysis. This type of analysis is known
as direct numerical simulation (DNS). Do this perfectly and you can exactly match laboratory
experiments.

Do we do this?

Yes, CFD analyses have been performed that exactly match laboratory experiments. In most cases
it was thought that the CFD analysis had not replicated the experiment. Further review however
demonstrated that experimental error and uncertainty was responsible for most of the difference.
Given the ability to extract any flow data from any point in the CFD domain, this methodology
has become an invaluable tool in turbulence-related research. The computational costs of this
methodology are currently too great to justify applying this methodology to engineering problems.
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What is an engineer to do?

First, start by jumping through several math hoops to create the Reynolds stress equations:

∂

∂t
(uiuk) + Uj

∂

∂xj
(uiuk) = −

(
p

ρ

[
∂ui
∂uk

+
∂ui
∂uk

])
+

∂

∂xj
{− [(puk)δij + (pui)δkj ]− (uiukuj) + 2ν [(sijuk) + (sijuk)]}

−
[
(uiuj)

∂Uk

∂xj
+ (ukuj)

∂Ui

∂xj

]
− 2ν

[(
sij
∂uk
∂xj

)
+

(
skj +

∂ui
∂xj

)]
(6.4)

The RHS terms are commonly referred to as:

• Pressure-strain rate

• Turbulence transport

• Production

• Dissipation

Close inspection of the equations will show that there are more unknowns than variables. Now
a methodology needs to be derived that allows an approximate solution of the equations. To
derive the methodology, it’s customary to simplify the equations by introducing a new term for the
turbulent kinetic energy:

k ≡ 1

2
(uiui) =

1

2
(q2) =

1

2

[
u2

1 + u2
2 + u2

3

]
(6.5)

Inserting k into (6.4) produces:[
∂

∂t
+ Uj

∂

∂xj

]
k =

∂

∂xj

{
−1

ρ
(pui)δij −

1

2
(q2uj) + ν

∂

∂xj
k

}
− (uiuj)

∂Ui

∂xj
− ν

(
∂ui
∂xj

∂ui
∂xJ

)
(6.6)

In this case on the RHS we have a rate of change of turbulent kinetic energy due to time-dependence
of the mean (first term) and for the rate of change of turbulent kinetic energy due to convection
by the mean flow (second term). On the LHS we have, in order:

• Transport of kinetic energy due to pressure fluctuations, turbulence and viscous stresses

• Rate of production of turbulent kinetic energy from the mean flow

• Rate of dissipation of turbulent kinetic energy due to viscous stresses, also referred to as the
Reynolds stresses

We now need to develop a method to predict the Reynolds stress. To this end, in 1887 Boussinesq
introduced the concept of eddy viscosity.

− ρ ¯u′iu
′
j = µt

(
∂Ui

∂xj
+
∂Uj

∂xj

)
− 2

3
ρkδij (6.7)

In this case we need to predict µt and k. There are a variety of methods to predict these variables,
including one equation, two equation and Reynolds stress transport models. Below is a brief
description of each model type.
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• One equation models - One equation turbulence models solve one turbulent transport equa-
tion, typically for turbulent kinetic energy. One equation models are typically used for aero-
dynamic calculations, and are most suitable where the flow remains attached to the surface
and any separation present is mild.

• Two equation models - Two equation models are the most common types of turbulence
models. The models operate by solving for two transported variables. Most of the models
separate into two distinct categories:

– k− ε models - k− ε models solve for the turbulent kinetic energy (k) and the turbulent
dissipation rate (ε).

– k − ω models - k − ω models solve for the turbulent kinetic energy (k) and the specific
dissipation rate (ω).

For the two equation models, the first term represents the turbulent energy contained
in the flow and second term considers the scale (time or length) associated with the
turbulence.

• Reynolds stress models - Reynolds stress models solve a system of 7 equations to calculate all
Reynolds stresses. Only 6 stresses need to be solved for since the stress matrix is symmetric,
and a seventh equation is solved to determine the specific dissipation. The model is known
as a second-order closure model. While the Reynolds stresses are modeled, the model does
not perform well for wall-bounded turbulent flows. This is because [15]:

– Ad hoc wall reflection terms are required in most pressure-strain models to mask deficient
predictions for the logarithmic region of the boundary layer.

– Near-wall models typically that depend on the unit normal to the wall must be in-
troduced. This makes it virtually impossible to systematically integrate second-order
closures in complex geometry.

What’s this wall?

Recall, the first rule of fluid dynamics is that the velocity is zero at the wall. Further, basic fluid
dynamics tells us that there will be some velocity profile between the zero wall value and the bulk
flow velocity of the fluid. Finally, consider, without walls there would be no turbulence. The
shear stresses induced in the fluid decelerating near the wall induces rotational energy in the flow.
Rotational energy leads to vortices, vortices lead to 3-dimensional vortical structures, 3-dimensional
vortical structures are turbulence. Therefore, the shear stresses at the wall must be considered.

The Law of the Wall

In 1930, based on experimental evidence, Theodore von Karman proposed the Law of the Wall.
The Law of the Wall states that the average velocity of a turbulent flow is proportional to the
distance from that point to the wall. In general the Law of the Wall is only valid for the first 20%
of the flow height from the wall. In most cases the law takes a general logarithmic formulation,
where the velocity at a distance from the wall is given as:

u+ =
1

k
ln y+C+ (6.8)

Where:
y+ =

yur
v

(6.9)
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And:

ur =

√
τw
ρ

(6.10)

And:
u+ =

u

ur
(6.11)

Further, in implementation the model is modified to account for the velocity profile in the viscous
sublayer, y+ <= 5. In this region u+ is taken as y+. The figure below shows the velocity profiles
inherent with the Law of the Wall modeling method. As can be seen from the figure, neither the
viscous sublayer or logarithmic approximations fully capture the transition velocity profile in the
region 5 < y+ < 30.

Figure 6.2: The Law of the Wall

Other mean flow quantities such a temperature, production of turbulent kinetic energy and/or
species concentration can then be predicted, based on this assumed velocity profile. How some of
these quantities are calculated are dependent on the turbulence model selection. It should be noted
that when the Law of the Wall is explicitly used in the solution (i.e., there is minimal to no attempt
at near wall velocity profile resolution) these assumed profiles, and their associated quantities, will
influence the calculated wall values.

Depending on the near wall mesh resolution, in practice there are typically three methods used for
implementation of the Law of the Wall:

• High-y+ - The high y+ model assumes that the centroid of the near wall cell lies in the
logarithmic region (y+ > 30).

• Low-y+ - The low y+ model assumes that the mesh is resolved to the viscous sublayer. In
this case, wall laws are not used. While theoretically this occurs at y+ < 5, in practice the
mesh normal to the wall should be resolved enough to produce solution y+ values less than
1.
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• All-y+ - The all y+ model attempts to mimic the behavior of both the high and low y+

models to allow for relatively coarse grids with flows that stagnate, or have a greatly reduced
friction velocity. Additionally, most of these models contain a functional blending treatment
to better represent the velocity between the viscous sublayer and the logarithmic regions.

7 Example 3: Waste Heat Boiler Ferrule

What’s in this Example?

Basic Setup

The initial problem setup will familiarize the attendee with working
with more complicated geometric domains; sources of information for
more complex material properties; and establishing more complicated
monitors to track the solution.

Initial Validation

During this phase of the tutorial the initial assumptions used in the
model are validated. Additional checks are then performed on the
model to validate model selections.

Model Refinement
During this phase of the tutorial the results of analyses performed
with varying levels of model refinement are compared.

The Right Way
Finally, the results of analyses performed with a properly constructed
CFD model are explored.

Given:

A multi-piece ferrule assembly is used to provide thermal protection at the entrance to a Waste
Heat Boiler (WHB). The ferrule assembly consists of two ceramic pieces, the ferrule and a hex
head refractory brick. Between the ferrule and the tube, additional thermal protection is provided
by Kaowool fiber wrap (paper). The front face of the tubesheet is protected with a 1” layer of
Kaowool fiber board (board). Ferrule geometry has been created for this example based on typical
dimensions seen in industry. The ferrule assembly is shown in Figure 7.1. The WHB is a kettle
type boiler constructed of carbon steel with an operating pressure of 600 psig.

A

A

3" 1" 1 1
2 "

1 1
2 "2 1

2 "

1'-0"

45 20

4 3 5 2 1 6

51
2 "

1 FERRULE
2 KAOWOOL PAPER
3 BOARD
4 HEX REFRACTORY
5 TUBESHEET
6 TUBE

Figure 7.1: Ferrule Assembly

Information regarding the process gas stream is shown below.

• Operating pressure 19 psig (232,325.4 Paabs)
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• Inlet temperature 2,500 F (1,644.26 K)

• Gas molecular weight 30

• Number of tubes 210

• Tube pitch 2.75” (0.06985 m)

• Inlet mass flow rate 104,000 lbs/hr (13.131 kg
s )

• Inlet dynamic viscosity (m) 0.046 cP

• Inlet gas specific heat 1,372 J
kg−K

• Inlet gas thermal conductivity 0.10422 W
m−k

Further, the properties of the refractory, paper and board are available from vendor material data
sheets.
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Figure 7.2: Thermal Conductivity of Refractory Brick [16]
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Figure 7.3: Thermal Conductivity of Kaowool Paper[17]

Finally, the thermal properties for the steel are available from ASME BPVC Section II, Part D
[18].

60 of 110



USE OF CFD IN DESIGN 7 EXAMPLE 3: WASTE HEAT BOILER FERRULE

200 300 400 500 600 700 800 900 1000 1100

25

30

35

40

45

50

55

60

65
Carbon Steel Thermal Conductivity

Temperature [K]

T
h

er
m

a
l

C
on

d
u

ct
iv

it
y
[ W m

K

]

Data
Data Fit

y = −0.0437x+ 74.103
R2 = 0.9992

Figure 7.4: Thermal Conductivity for Low Carbon Steel [18]

Find:

As shown in PVP2011-57625 [19], PVP2009-78073 [20] and PVP2005-71143 [21], severe problems
and short-term failures can be caused in WHBs due to high metal temperatures; and/or the peak
heat flux through the steel. Metal temperatures greater than 600 ◦F will lead to a phenomenon
referred to as sulfidation, which causes corrosion on the tubes and loss of mechanical integrity. At
extreme temperatures and fluxes, the water on the outside of the tubes ceases to leave the surfaces
in jets and columns and instead forms a film over the heating surface. In this situation, referred to
as departure from nucleate boiling (DNB), the film coefficient on the exterior surface of the tube
instantly decreases by more than an order of magnitude, resulting in a rapid rise in tube metal
temperature. In the most extreme circumstances, the metal temperature can exceed the short-term
creep temperature limit and the tube can undergo catastrophic failure, usually resulting in buckling
rupture.

For these reasons, CFD analyses are typically used to categorize the magnitude of the peak flux and
associated temperatures in these assemblies. The use of the information from a series of analyses
based on typical operational process conditions can aid in establishing process limits to avoid boiler
damage.

7.1 Understanding the Physics

The choice of mesh topology will be dependent on the expected velocities under the considered
conditions. To determine the velocities, one must first determine the volumetric flow rate per tube.
From basic fluid mechanics, assessing the volumetric flow rate requires determining the density.
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The density is computed as follows:

ρ =
P

R∗T
(7.1)

Where:

• ρ - density

• R∗ - Specific gas constant (8314.4621 J
K−kmol ·

1
30

kg
kmol = 277.1487 J

kg−K )

• T - temperature

Applying (7.1) with known values

ρ =
232, 325.4 N

m2

277.148 N ·m
kg−K 1644.26K

= 0.5098
kg

m2
(7.2)

The volumetric flow rate per tube can then be computed:

q̇ =
ṁ

Nt · ρ
(7.3)

Where:

• q̇ - Volume flow rate per tube

• ṁ - Total system mass flow rate

• Nt - Total number of tubes

Applying (7.3) with known values

q̇ =
13.131 kg

s

210 · 0.5098 kg
m3

= 0.12265
m3

s
(7.4)

Given the tube’s pitch, the model inlet velocity can be determined:

V =
q̇

A
(7.5)

Where:

• A - Model inlet area 23.758 in2 (0.01533 m2)

Substituting values into (7.5)

V =
0.12265 m3

s

0.01533m2
= 8

m

s
(7.6)

The maximum velocity through the ferrule can then be determined through the area ratio. From
Figure 7.1, the radius of the ferrule is 0.86” (0.021844 m). In this case, the peak bulk velocity will
be 81.8 m

s . We can use this information to compute the peak Reynolds number.

Re =
ρV L

µ
(7.7)

Where:
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• Re - Flow Reynolds number

• L - Pipe diameter

Substituting known values to calculate the Reynolds number from (7.7):

Re =
0.5098 kg

m3 81.8m
s 0.043688m

4.6 · 10−5 Pa · s
= 39, 606 (7.8)

As the Reynolds number is greater than 4,000, it is expected that the flow will be turbulent.

If we assume γ is 1.4, the speed of sound in the gas is:

c =
√
γ ·R∗ · T (7.9)

Or:

c =

√
1.4 · 277.1487

J

kg −K
· 1644.26K = 798.7

m

s
(7.10)

We can now calculate the flow Mach number:

M =
V

c
=

81.8 m
s

798.7 m
s

= 0.102 (7.11)

The flow Mach number is significantly below 0.3 so velocity compressibility effects will be negligible.
While it is expected that the gas will undergo a significant change in density throughout the boiler
due to the gas’ change in temperature, in the small region near the inlet we will treat the gas as
incompressible. Steps will need to be taken to verify this assumption after solution.

7.2 Select the Computational Volume

This is a conjugate heat transfer problem, which means all of the assembly’s components will need
to be included to allow proper computation of all heat paths. This provides seven computational
volumes:

• Gas

• Ferrule

• Refractory

• Board

• Kaowool

• Tubesheet

• Tube

For the purpose of this tutorial, an axisymmetric model will be used. The use of an axisymmetric
model will reduce computation time. In an axisymmetric model all of the model components will
be represented with 2-dimensional grids and the geometry for the solid components can be directly
extracted from the 3D geometry. Surface geometry must be constructed for the gas space.

Constructing the gas volume requires consideration of the expected flow regimes. Assume that
a constant velocity inlet boundary condition will be used for the model. From a review of the
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geometry it is expected that the constant inlet velocity will contract to enter the ferrule. To mini-
mize errors introduced by the constant velocity requires creation of a volume in front of the ferrule
entrance to allow the software to calculate the flow paths. For the initial models we will use a 3”
long volume. This distance may need to be modified in subsequent models.

Further review of the model indicates that a recirculation zone downstream from the step at the
ferrule’s termination should be expected. As no boundary conditions exist that will successfully
capture the details of recirculation across a model boundary, the gas volume should be extended
downstream from this location. Once again a relatively arbitrary distance of 1’ was selected for the
initial model. Tthis distance may need to be modified based on the results of the initial analysis.
Incorporating these assumptions produces the initial gas volume seen in Figure 7.5.

In this case additional work needs to be done to define surfaces that will be incorporated into inter-
face sets before the computational grid is developed. To accomplish this, each component will be
surveyed to determine other components that it interfaces with, and the interface location. While
the final model will be 2-dimensional, for the purposes of clarity, all of the following figures were
developed by creating a 30 sector model from the full 3D geometry.

Figure 7.5: Ferrule 3D Geometry

The tube will have four interface locations and an additional two boundary condition locations:

• Tube to gas (interface)

• Tube to kaowool (interface)

• Tube to board (interface)

• Tube to tubesheet (interface)

• Tube to shell side water (boundary condition)

• Tube end (boundary condition)
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END

TUBE TO SHELL SIDE WATER

TUBE TO TUBESHEET

TUBE TO GAS

TUBE TO KAOWOOL

TUBE TO
BOARD

Figure 7.6: Tube Boundary Conditions

The tubesheet will have two interface locations and two boundary condition locations:

• Tubesheet to tube (interface)

• Tubesheet to board (interface)

• Tubesheet exterior (boundary condition)

• Tubesheet to shell side water (boundary condition)

TUBESHEET TO WATER

EXTERIOR

TUBESHEET TO TUBE

TUBESHEET TO BOARD

Figure 7.7: Tubesheet Interfaces and Boundary Conditions

The board will have four interface locations and one boundary condition location:

• Board to tubesheet (interface)

• Board to tube (interface)

• Board to kaowool (interface)

• Board to refractory (interface)
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• Board exterior (boundary condition)

BOARD TO TUBE

BOARD TO TUBESHEET

EXTERIOR

BOARD TO KAOWOOL

BOARD TO REFRACTORY

Figure 7.8: Board Interfaces and Boundary Conditions

The refractory will have 4 interface locations and one boundary condition location:

• Refractory to board (interface)

• Refractory to kaowool (interface)

• Refractory to ferrule (interface)

• Refractory to gas (interface)

• Refractory exterior (boundary condition)

EXTERIOR

REFRACTORY TO BOARD

REFRACTORY TO KAOWOOL

REFRACTORY TO FERRULE

REFRACTORY TO GAS

Figure 7.9: Refractory Interfaces and Boundary Conditions

The kaowool will have five interface locations:

• Kaowool to gas (interface)

• Kaowool to ferrule (interface)

• Kaowool to refractory (interface)

• Kaowool to board (interface)

• Kaowool to tube (interface)
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KAOWOOL TO GAS

KAOWOOL TO TUBE

KAOWOOL TO BOARD

KAOWOOL TO REFRACTORY

KAOWOOL TO FERRULE

KAOWOOL TO FERRULE

Figure 7.10: Kaowool Interfaces and Boundary Conditions

The ferrule will have 3 interface boundary condition locations:

• Ferrule to gas (interface)

• Ferrule to kaowool (interface)

• Ferrule to refractory (interface)
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FERRULE TO KAOWOOL

FERRULE TO KAOWOOL

FERRULE TO REFRACTORY

FERRULE TO GAS

Figure 7.11: Ferrule Interfaces and Boundary Conditions

The gas volume will have four interface and three boundary condition locations:

• Gas to ferrule (interface)

• Gas exterior (interface)

• Gas to kaowool (interface)

• Gas to tube (interface)

• Gas to refractory (interface)

• Inlet (boundary condition)

• Outlet (boundary condition)

• Axis (boundary condition)
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GAS TO TUBE

GAS TO FERRULE

GAS TO REFRACTORY

OUTLET

INLET

GAS TO KAOWOOL

GAS TO FERRULE

AXIS

Figure 7.12: Gas Interfaces and Boundary Conditions

7.3 Create the Computational Grid

Once the surfaces have been divided, the computational grid can be constructed. As this is a
conjugate heat transfer problem, a conformal grid will be constructed to avoid any numerical
inaccuracies at the interface locations. The initial mesh size will be chosen to provide 15 elements
through the ferrule contraction and no biasing will be employed. The initially constructed grid
(referred to as Mesh 1) contains 20,610 elements and is shown in the Figures below.

Figure 7.13: Grid Near Ferrule Inlet Location
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Figure 7.14: Grid Near Ferrule Termination

7.4 Selection of Physics Models

Five continua will be defined:

• Refractory (Solid)

• Kaowool (Solid)

• Board (Solid)

• Steel (Solid)

• Gas (Gas)

For the solid components, the following properties will be defined:

• Space - Axisymmetric

• Time - Steady

• Material - Solid

• Solid Segregated* Energy

• Equation of State - Constant density

* See discussion below on the choice of the Segregated solver

Each of the solid continua requires input of the density, specific heat and thermal conductivity. As
this is a steady-state analysis, the density and specific heat will be defined as constants at nominal
values.

Table 7.1: Material Properties [22]

Material Density kg
m3 Specific Heat J

kg−K

Refractory 3960 1250
Kaowool 48 1000
Board 320 1100
Steel 8000 450

The thermal conductivities for the materials were applied based on the material curve fits above.
(Note: Due to the iterative solution process used during the CFD solution, non-linear properties
are easily incorporated into CFD models.)
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The refractory continuum is assigned to the refractory and ferrule computational volumes. The
steel continuum is assigned to the tube and tubesheet computational volumes. The remaining con-
tinua are assigned to their logical volumes.

The flow in this case is at a low Mach number (M < 0.3), without compressibility effects the
Segregated solution method is the proper choice for the initial analysis. For this analysis we will
select the default models for the gas continuum, which are as follows:

• Space - Axisymmetric

• Time - Steady

• Material - Gas

• Equation of State - Constant density

• Turbulent - RANS, Realizable k − ε, Two-layer all y+ Wall Treatment

• Segregated Fluid Temperature

The gas material properties are defined using the information above. The gas physics continuum
is assigned to the gas computational volume.

7.5 Applying Boundary Conditions

As discussed above, for the initial analysis, a constant velocity profile of 8 m
s will be assigned at

the inlet condition. Additionally, the inlet temperature should be defined at 2500◦F. Turbulence
quantities will need to be calculated for the inlet.

First we will assume that the intensity can be calculated based on fully developed pipe flow. Note
in critical analyses some measure of the turbulence level in the thermal reactor would need to be
established. In this case the turbulence intensity at the core and the associated length scales are:

I = 0.16Re
− 1

8
D

I = 0.16 · 39, 606−
1
8 = 0.0426

l = 0.07dh

l = 0.203′′

(7.12)

For this problem we will assign a pressure outlet at the model outlet. The use of a pressure outlet
will allow us to control the pressure in the computational domain. If, after the first analysis, we
invalidate the compressibility assumption, having established pressure control will allow an easier
transition to an ideal gas model for the gas Equation of State. In this case we will assign a con-
stant back pressure equal to the nominal system operational pressure (19 psig). Next, the axis of
symmetry should be assigned as an Axis boundary condition and the outer edge of the gas should
be changed to a symmetry boundary condition.

For the water side we know that the bulk temperature is 486◦F [23]. In this case we will assign
a film coefficient of 1,409 BTU/hr-ft2◦F (8,000 W/m-K), which is in the general range for film
boiling coefficients [24]. The selection of the water side film coefficient should not affect the results
significantly, as a coefficient this high represents almost no thermal resistance in the heat trans-
fer system. We change the thermal specification for the boundaries tube-to-shell-side water and
tubesheet-to-shell-side water from adiabatic (default) to convection, then assign the film coefficient
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and bulk temperature.

For the other boundaries within the model (Tube end, Tubesheet exterior, Board exterior and Re-
fractory exterior), the default thermal specification (adiabatic) is acceptable for this model.

Finally, all of the interfaces discussed in Select the Computational Volume should be assigned.
Star-CCM+ should automatically define the proper interface types since we have already assigned
the proper physics continua to each computational volume. For this class of problem, all interface
sets should be assigned as contact interfaces. There will be 13 interface pairs.

7.6 Initializing the Model

Based on the information we have developed for the model, we know some information to aid in
setting the proper initial conditions for the gas continuum. We know that the inlet velocity will
be 8 m

s and that, given the model’s geometry, the downstream velocities should be greater than
this value. It is also known that the inlet temperature is 2,500◦F and that the system pressure
is 19 psig. While calculations could be performed to determine the bulk velocities at downstream
locations, and these bulk velocities could be applied using a variety of methods for initialization,
there is likely little solution benefit for this problem. For the initial solution we will not calculate
values for the initial turbulence values. Therefore, the static values discussed above are applied to
the gas continuum.

For the solid physics continua, the only initial condition applied is the temperature. From reviewing
the assembly geometry we can assume that the refractory material will be near the gas temperature,
the steel will be near the water temperature and the board and kaowool will be somewhere in-
between. Therefore, based on a cursory inspection we can assign the following values to the physics
continua:

• Refractory 2,300 ◦F

• Steel 500 ◦F

• Board and Kaowool 1,400 ◦F

A model Mesh1 real ke where the steps discussed to this point have been applied has been provided
as Mesh1 real ke.sim.

7.7 Solve

7.7.1 Section 1

This section will review establishing meaningful solution monitors and the use of the monitors dur-
ing the solution process to ensure converged results.

Prior to beginning, the solution monitors should be created to allow review of the solution’s progress.
At a minimum, scenes should be created to allow visualization of the velocity and temperature
distributions throughout the assembly. Also monitors should be established to track the parameters
of interest (temperature and heat flux) as the solution progresses. Since we are only interested
in the peak metal temperature, we can establish a per iteration monitor of the maximum steel
temperature. To better track the heat flux we are interested in the flux’s spatial distribution at
the gas interface to the tube. To monitor this data an X-Y plot of the flux will be created at this
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location. Finally, as turbulence is included in the model we are interested in the Wall y+ value.
Therefore, we will create the following scenes:

• Velocity contour plot

• Temperature contour plot

• Per iteration maximum temperature monitor

• X-Y heat flux spatial distribution

• X-Y wall y+ spatial distribution

Once the plots are established we will perform 350 iterations on the problem. Below are the
commands to complete these tasks in Star-CCM+
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Star-CCM+ Commands

1. File →Load Simulation →Browse →Ex3 mods →
Mesh1 real ke.sim →OK

2. Scene →New Scene →Scalar

3. Scenes

→ Scalar Scene 1 (Right Click) →Rename →Velocity

→ Velocity

→ Displayers→Scalar 1→Scalar Field→Velocity: Mag-
nitude

→ Scalar 1 →Smooth Filled

4. Velocity (Collapse) →Ctrl-C

5. Scenes (Right Click) →Paste

→ Copy of Velocity (Right Click) →Rename →Temperature

→ Temperature

→ Displayers →Scalar 1 →Scalar Field →Temperature

→ Units →F

6. Reports (Collapse)

7. Plots →Max Metal Temp Monitor Plots (Double Click)

8. Plots (Right Click) →New Plots →X-Y

→ XY Plots 1 (Right Click) →Rename →Wall Heat Flux

→ Parts →fluid main gas 2D →Select Interface set
wall fluid 2 tube [In-place 10]

→ Y-Types →Y Type 1 →Scalar →Boundary Heat Flux

9. Collapse Wall Heat Flux

10. Select Wall Heat Flux →Ctrl-C

11. Plots (Right Click) →Paste

→ Copy of Wall Heat Flux (Right Click) →Wall y+

→ Y Types →Y Type 1 →Scalar →Wall y+

12. Wall y+ (Collapse) →Right Click and Open

13. Save

14. Switch to Scene Temperature

15. Initialize the Problem

16. Verify temperature profile is the same as Figure 7.15
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Figure 7.15: Verification of Temperature Profile

Star-CCM+ Commands

1. Switch to Scene Velocity

→ Verify velocity initial conditions were applied correctly to
the model

2. Stopping Criteria →Maximum Steps →305

3. Run

At the conclusion of 350 iterations all residuals have decreased by 3 orders of magnitude and it
appears that the peak value of metal temperature has stabilized. This can be seen in Figure 7.16.

It can be stated that for the mesh and boundary conditions used in this example, the value of
maximum metal temperature has converged. As a secondary measure of convergence, monitor the
X-Y plot of heat flux for an additional 150 iterations.

Star-CCM+ Commands

1. Switch Scene to Wall Heat Flux

2. Stopping Criteria →Maximum Steps →500

3. Run

During the additional 150 iterations, some slight movement in the tail of the plot (near the outlet)
is evident, but there is no bulk change in the shape or values near the peak flux location. It can
now be stated that for the mesh and boundary conditions used in this example, the wall heat flux
has converged.

Am I Done?

75 of 110



USE OF CFD IN DESIGN 7 EXAMPLE 3: WASTE HEAT BOILER FERRULE

0 50 100 150 200 250 300 350 400 450 500

515

520

525

530

535

540

545

550

555

560
Maximum Temp Monitor Plot

Iteration

M
ax

im
u

m
T

em
p

er
at

u
re

[F
]

Figure 7.16: Maximum Metal Temperature

NO!

7.7.2 Section 2

In this section the basic assumptions used during the initial model development will be validated.

At this point in the solution, none of the assumptions used in constructing the model have been
validated. As a first check, the adequacy of the near-wall mesh resolution for selected the turbulence
model should be verified. In this case the maximum value of Wall y+ is approximately 25. Two-
Layer K-Epsilon models will produce the least inaccuracies for intermediate meshes (1 < y+ < 30).
Therefore, the turbulence treatment meets the criteria for the model.

Next the incompressible assumption should be validated. To perform this task, create a surface-
based monitor for the gas outlet that records average temperature. In this case the outlet tem-
perature is 2,229◦F (1,494 K) indicating that there would be an approximately 9% change in gas
density. Remember to perform this calculation using absolute temperatures. As the gas cools down
it will become denser resulting in lower velocities than those predicted in the CFD model. The
decrease in velocity should decrease the predicted heat flux near the cold end, away from the area
of interest. For this reason the assumption can be taken as valid in this case.
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Star-CCM+ Commands

1. Reports →New Report →Surface Average

→ Outlet temp →Scalar Field Function →Temperature

→ Parts →fluid main gas 2D →outlet fluid outlet

2. Right Click →Run Report

Finally, validate the selected domain extents. For now, use visual cues to determine whether the
domain is adequate. First, inspect the velocity profiles near the inlet.

Figure 7.17: Velocity Profiles Near Ferrule Entrance, Mesh 1, Realizable k−ε Two-Layer Turbulence

Inspection of the calculated velocity profiles near the inlet shows that the rapid change in velocities,
from a bulk 8 m

s to a peak 101 m
s does not begin near the defined velocity inlet. In this case the

selection of domain extents near the inlet is adequate.

Next, inspect the velocity profiles near the model outlet.
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Figure 7.18: Velocity Profiles Near Ferrule Exit, Mesh 1, Realizable k − ε Two-Layer Turbulence

Inspection of the calculated velocity profiles near the outlet shows that there remains a wide dis-
tribution in velocities. In this case the flow is still expanding into the tube after being accelerated
through the ferrule. Of importance in the velocity profiles is that the expected recirculation region
downstream from the ferrule does occur. Additionally, this recirculation region terminates several
diameters upstream from the outlet boundary condition. Finally, during solution no outlet recircu-
lation messages were received. For this model the selection of the domain extents near the outlet is
adequate. For a production level analysis, further analysis would likely be required to bound any
influence on the domain extents on the calculated results.

So I performed some validation, I’m done now, RIGHT?
No!

So far, the analysis has only been performed with the de facto turbulence model - The Realizable
k− ε with Two-Layer y+ Treatment. Recall that the selection of a wall law can significantly affect
near and at wall calculated values, including heat transfer. A second analysis should be performed
to determine the effect, if any, the choice of turbulence model has on the calculated results. For the
peak y+ values predicted during the first analysis, a Two-Layer y+ Model is the most appropriate,
so we will modify the model selection from Realizable to Standard k − ε. First, we should record
some values for comparison to future analysis results. At a minimum the following values should
be recorded (you should be able to create the appropriate reports by now):

• Maximum metal temperature 530.4◦F

• Maximum Wall y+ value near tube 24.5

• Peak heat flux on tube wall 172,800 W
m2

• Average solver time per iteration* - 0.22 s

* Solver time per iteration commands are given below
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Star-CCM+ Commands

1. Report →New Report →Solver Iteration Elapsed Time

→ Solver Iteration Elapsed Time (Right Click) →Create
Monitor and Plot

→ Solver Iteration Elapsed Time Monitor Plot (Right Click)
→Open

→ Stopping Criteria →Maximum Steps →510

2. Run

3. Go to Solver Iteration Elapsed Time Plot →Eyeball elapsed
time

Now modify the turbulence model.

Star-CCM+ Commands

1. Continua →Gas →Right Click on Models →Select Models

2. NOTE: Make sure auto-select recommended models is not se-
lected

→ Unclick →Two-Layer All y+ Wall Treatment

→ Unclick →Realizable K-Epsilon Two-Layer

→ Click →Standard K-Epsilon Two-Layer

→ Click →Two-Layer All y+ Wall Treatment →Close

3. File →Save As →Mesh1 standard ke →Save

4. Stopping Criteria →Maximum Steps →1000

5. Switch to Wall Heat Flux Plot

6. Run

As the solution progresses a“wave” travels through the heat flux plot (this is also apparent on other
plots). At the conclusion of 490 iterations, the solution residuals have not lowered by 3 orders of
magnitude and the peak metal temperature has not stabilized. Consequently, an additional 250
iterations must be run. At the conclusion of 250 additional iterations the peak heat flux and
maximum metal temperature plots have stabilized and the residuals have been reduced by three
orders of magnitude. Querying the solution values defined above provides the following results:

• Maximum metal temperature 543.4◦F

• Maximum Wall y+ value near tube 31.6
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• Peak heat flux on tube wall 228,220 W
m2

• Average solver time per iteration* - 0.24 s

The peak metal temperature has increased by 13◦F, or using 486◦F as the background temperature,
by approximately 30%. The peak heat flux has increased by 32%. Furthermore, inspection of the
shape of the heat flux curves shows:
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Figure 7.19: Comparison of Fluxes Predicted with Realizable and Standard k − ε Models, Mesh 1

As can be seen from the figure the shape and value near the peak heat flux location is entirely
different depending on the selection of the turbulence model. Downstream from the peak flux
location, the calculated fluxes are almost identical. In this case no engineering decision can be
made with any certainty regarding the peak flux or metal temperature. Based on the Wall y+
values calculated from the previous analyses, a third Two-Layer All y+ turbulence model should
be implemented to provide more insight into the calculated results. In this case we will move from
the k− ε models to k− ω models. Specifically, we will use the most basic k− ω model, the Wilcox
Standard k − ω model [25].

Plotting the heat flux along the exposed tube face provides:
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Figure 7.20: Comparison of Fluxes Predicted with Realizable and Standard k − ε Models and
Wilcox k − ω Model

Obviously, there is no convergence in the peak value of heat flux or in its distribution near the peak
flux location.

Uh Oh!

7.7.3 Section 3

In this section the effect of grid refinement on the predicted temperatures and fluxes will be explored.

At this point, with unconverged - or grid dependent - results, most analysts will resort to grid
refinement. In this case the most basic refinement step will be taken, the fluid grid will be divided
at mid-points resulting in four times as many cells. In this case the grids for the solid elements will
not be divided. As the divided grid started as a conformal mesh, when it is divided the interfaces
will maintain 100% face matching. The divided grid (Mesh 2) contains 63,749 cells. The figures
below show the divided grid.
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Figure 7.21: Mesh 2 Grid Topology Near Ferrule Inlet

Figure 7.22: Mesh 2 Grid Topology At Ferrule Outlet

Using the techniques described in Example 2, the gas grid is swapped and the solution is recon-
verged. The following quantities can be queried from the converged model.

• Maximum metal temperature 535.4◦F

• Maximum Wall y+ value near tube 10.1

• Peak heat flux on tube wall 191,860 W
m2

• Average solver time per iteration - 0.70 s
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Figure 7.23: Comparison of Previous Fluxes with Flux Predicted Using Realizable k − ε Model,
Grid 2

The shape of this flux curve provides no further insight into what may be the correct flux value.
Re-run this mesh with the Standard k− ε Two Layer All y+ and Wilcox k−ω Two Layer All y+.
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Figure 7.24: Comparison of Fluxes Predicted with Three Turbulence Models and Two Mesh Topolo-
gies

The flux values predicted from this analysis still do not provide clear insight into the maximum
heat flux value that can be expected. Furthermore, as shown in, Table 7.2 there still has been no
convergence in the peak metal temperature.

Table 7.2: Peak Quantities Comparison

Grid Turbulence Model
Maximum Metal
Temperature (◦F)

Maximum
Wall y+

Peak Heat Flux
(
W
m2

)
Mesh 1

Realizable k − ε 530.4 24.5 172,800

Standard k − ε 543.4 31.6 228,220

Wilcox k −O 527.3 19.5 160,550

Mesh 2

Realizable k − ε 535.4 10.1 191,860

Standard k − ε 547 13 240,610

Wilcox k −O 537 7.8 198,330

Refine the grid by mid-point splitting the elements again and re-run. The refined grid (Mesh 3)
contains 236,649 computational cells and is shown in the figures below.
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Figure 7.25: Grid 3 Topology Near Ferrule Inlet

Figure 7.26: Grid 3 Topology Near Ferrule Outlet

The solution of the Mesh 3 grid topology with the Standard k−ε Two-Layer All y+ model displayed
interesting behavior. As shown in the figure below, the residuals have been reduced by 3 orders of
magnitude, which would be an indication that the solution has converged.
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Figure 7.27: Reconverged Residuals

The wall heat flux along the tube demonstrates suspicious behavior at this stage of the solution.
As can be seen in the figure below, there are regions on the flux plot where the derivative is large*.

* As a sidenote from the analyst, rarely in nature will one see very rapid changes in the state of a
variable.
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Figure 7.28: Heat Flux into Tube

In this case, an analyst who was not vigilant in reviewing results might rely only on the state of
the solution residuals. He or she could have output solution variables from reports, contour plots
and other analysis information without the knowledge that the solution was inaccurate.

The fluxes were extracted for the 3 models as shown below.
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Figure 7.29: Comparison of Peak Heat Flux

Once again, no convergence trends are evident in the results. During the solution a new trend in
the distribution of Wall y+ values at the tube interface was discovered, as shown in Figure 7.30.
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Figure 7.30: Comparison of Wall y+ Values by Mesh Density and Wall Law
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As you can see from the figure, only at the near wall densities present in the Mesh 3 grid topology
was the boundary layer resolved enough to capture a stagnation point occurring downstream from
the recirculation introduced by the ferrule’s termination.

As can be seen from Table 7.3, there remains a wide variance in both the peak metal temperature
and peak recorded flux.

Table 7.3: Peak Quantities Comparison

Grid Turbulence Model
Maximum Metal
Temperature (◦F)

Maximum
Wall y+

Peak Heat Flux
(
W
m2

)
Mesh 1

Realizable k − ε 530.4 24.5 172,800

Standard k − ε 543.4 31.6 228,220

Wilcox k −O 527.3 19.5 160,550

Mesh 2

Realizable k − ε 535.4 10.1 191,860

Standard k − ε 547 13 240,610

Wilcox k −O 537 7.8 198,330

Mesh 3

Realizable k − ε 537.5 3.7 200,220

Standard k − ε 543.6 4.1 226,110

Wilcox k −O 534.4 3.6 188,930

Table 7.4 summarizes the computational expense for each model.

Table 7.4: Computational Expense

Grid Turbulence Model
Solver Time per

Iteration (s)
Iterations to

Converge

Total CPU
Time (s)

Mesh 1

Realizable k − ε 0.22 500 110

Standard k − ε 0.24 600 144

Wilcox k −O 0.22 430 95

Mesh 2

Realizable k − ε 0.9 1,000 1,012

Standard k − ε 0.88 1,250 1,239

Wilcox k −O 0.83 1,000 921

Mesh 3

Realizable k − ε 2.72 1,500 5,092

Standard k − ε 2.44 2,837 8,161

Wilcox k −O 2.52 2,000 5,951

As can be seen from the table, gross refinement of the model has come at a significant expense due to
the increased number of iterations required to converge the model and the additional computational
expense per iteration. No greater resolution to the engineering quantities of interest has occurred.

Maybe I should work smarter?
Yes!
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7.7.4 Section 4

In this section we will compare the results for a properly developed computational grid to the results
from the previous sections.

It should be apparent by now that the solution for this problem is dependent on both the selected
grid density and the choice of a turbulence model, i.e., which wall laws are implemented. When
this type of model response is evidenced, it is good practice to reduce the model’s dependence
on the selection of wall treatment. This is accomplished by reducing the distance to the first cell
centroid next to the wall by constructing layers of elements in the near wall region. This results in
better capture of the boundary layer, rather than relying on wall law approximations to describe
the near wall velocity field. Generally, the near wall mesh should be able to support low y+ wall
formulations (y+ < 1).

Inspection of the velocity results from the previous analyses indicates that there are two areas in
the model where mesh refinement should be employed to capture high strain gradients, near the
ferrule’s inlet bevel and in the recirculation zone.

Figure 7.31: Velocity Profiles Near Ferrule Entrance
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Figure 7.32: Velocity Profiles Downstream from Ferrule

The location for mesh refinement near the ferrule chamfer is obvious. The results of the previous
analyses can be used to determine how far downstream from the ferrule termination the mesh should
be refined to capture the recirculating flows. Recall from the Section 3 results that a stagnation
point became evident from the Wall y+ plot for the Mesh 3 grid topology.
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Figure 7.33: Wall y+ Values with Mesh 3

Inspection of this plot shows that the stagnation point occurs approximately 0.13 m (5”) down-
stream from the ferrule’s termination. Additionally, a line-probe can be applied to the model.
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This probe can then be used to query the axial velocity at this location to determine the limits of
recirculation.

Star-CCM+ Commands

1. Right Click on Derived Parts →New Part →Probe →Line

→ Input (0.27584, 0.03175, 0), (0.58064, 0.03175, 0) as the
line start and end points

→ No Geometry Displayer →Create

2. Right Click on Plots→New Plot→X-Y (assign a logical name)

→ Parts →Derived Part →Line Probe

→ X Type →Default vector direction is acceptable

→ Y Type →Y Type 1 →Velocity →i

→ Open Plot
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Figure 7.34: Axial Velocity vs Position

From this plot it is evident that the recirculation also occurs less than 0.13 m (5”) downstream from
the ferrule’s termination. In this case if the grid is refined for 6” downstream from the ferrule’s
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termination all relevant flow features should be captured.

A new grid was developed that incorporated mesh biasing towards the two relevant flow features
and near wall refinement to allow the use of low y+ wall models. The new grid contained 38,459
computational cells and is shown in the figures below.

Figure 7.35: CFD Developed Grid near Ferrule Entrance, First Refinement Level

Figure 7.36: CFD Developed Grid near Ferrule Exit, First Refinement Level

Additionally, while the initial grid was under development two additional grids, with greater bound-
ary layer densities, were created. The difference in boundary layer density is shown in the figures
below.
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Figure 7.37: Grid 1 Boundary Layer Topology

Figure 7.38: Grid 2 Boundary Layer Topology
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Figure 7.39: Grid 3 Boundary Layer Topology

We will first run the Grid 1 topology with the Realizable k−ε model to allow a direct comparison to
the results calculated in the previous section. Figure 7.40, Figure 7.41, Figure 7.42 and Figure 7.43
show comparisons of the velocity profiles calculated during Section 3 to the velocities calculated
with the CFD developed grid.
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Figure 7.40: Peak Velocities Occurring Near Ferrules Inlet, Mesh 3 Topology

Figure 7.41: Peak Velocities Occurring Near Ferrule Entrance, CFD Grid 1 Topology
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Figure 7.42: Recirculation Occurring at Ferrule Outlet, Mesh 3 Topology

Figure 7.43: Recirculation Occurring at Ferrule Outlet, CFD Grid 1 Topology
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An inspection of the velocities calculated for each model shows relatively good agreement, with
the general shape of the velocity distributions remaining constant and only slight changes in the
velocity magnitudes. The flux distributions between models were then compared.
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Figure 7.44: Comparison of Fluxes with Over-Refined Model and CFD Developed Grid

The Wall y+ values for the model can then be queried. As can be seen from the figure below, the
y+ values are less than 1, indicating that a low y+ wall law is appropriate.
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Figure 7.45: Wall y+, CFD Grid 1

Due to the presence of the flow stagnation point, the standard, non-modifiedk − ε models will not
be considered, leaving the following options:

• AKN k − ε Low-Re

• V2F k − ε
• k-ω Wilcox

• k-ω Menter
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Figure 7.46: Comparison of Predicted Fluxes by Turbulence Model, CFD Grid 1l

In this case, two of the low y+ models, AKN and V2F, have predicted much higher fluxes than
any models used to this point. This peak flux value is greater than all values previously predicted
values, with the exception of the values predicted with the Standard k − ε All y+ model, which
was considered an anomaly.

In this case we will then run the selected turbulence models with the refined grids.
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Figure 7.47: Flux Comparison for V2F Model
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Figure 7.48: Flux Comparison for AKN Model
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Figure 7.49: Flux Comparison for Wilcox Model
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Figure 7.50: Flux Comparison for Mentor Model
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It can be stated that grid independence has been established for all of the turbulence model sets.
Below is a comparison of the results.
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Figure 7.51: Comparison of Fluxes for Four Turbulence Models

Obviously the predicted flux values are converging closer to a final value, with a likely peak flux
between 225,000 W/m2 and 275,000 W/m2. While there is still a 20% spread in the estimated flux
value, it should be noted that the values predicted using true CFD methodology are all greater than
the values predicted using standard mesh refinement techniques in Section 2, with the exception of
the value predicted using the Standard k − ε model. In this case it can be stated that an analyst
who used the methodology in Section 2 while arriving at the Standard k − ε peak flux was lucky
instead of good.

What Have We Learned?

In this example we learned:

• For a grid that would look acceptable to an FE analyst:

– Grid independence was never achieved

– No measurable indicators showed a stagnation region until the highest level of refinement

– Depending on the model measures established, an analyst may not have received feedback
that an incorrect solution had been achieved

• For a grid that was developed for CFD analysis:

– Grid independence was achieved for all turbulence models
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– The stagnation point was apparent in all models

– The peak heat fluxes did not converge

Given these results, interpretation of the data may be possible depending on the purpose. For design
comparison analyses qualitative data comparisons could be performed. If enough historical data
was available, including occurrences of failures, data from several analyses, performed using the
same methodologies could be used to establish operational limits. If no historical data is available,
the maximum predicted flux values could be used, or a more rigorous modeling methodology may
be warranted.

8 Advanced Topics

• DES and LES turbulence modeling

• Porous media

• Including radiation in the energy calculation

• Multi-component flows, including:

– Multi-species

– Volume of fluid

– Lagrangian methods, and

– Reacting flows

• Transient Analyses

8.1 DES and LES Turbulence Modeling

Discrete Eddy Simulation (DES) and Large Eddy Simulation (LES) provide a bridge between DNS
and RANS methods. For both methods the wall models are modified to behave like a DNS model
in the near wall vicinity, while away from the wall the models behave as RANS models. The im-
plementation of both models requires a significantly refined grid topology to capture all relevant
near wall effects and a sufficiently small time-step to capture the eddy behavior.

To demonstrate the use of DES, the axisymmetric model developed for the ferrule analysis was
modified to a 3-dimensional periodic model. A transient analysis was then performed for a suffi-
cient period of time to reach a quasi-steady-state solution. This required 139,000 time-steps, or 2.8
million iterations.

Figure 8.1 and Figure 8.2 show the vorticity and temperatures from a single step during the analysis.
As can be seen from the figures, the calculated flow field is no longer regular as calculated during
a RANS analysis. During the tutorial, an animation will be used to demonstrate the time-history
nature of the flow field.
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Figure 8.1: Vorticity Downstream from Ferrule Outlet

Figure 8.2: Temperatures Downstream from Ferrule Outlet
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8.2 Porous Media

Porous media models within CFD are used to model regions that consist of solid particles with
interstitial voids. Porous media models do not consider the fine scale details of the flow through the
media; instead, they allow calculation of the macroscopic effects of the medium on the bulk fluid
flow. The porous media model is implemented through the creation of momentum source terms
for the defined porous region. The momentum source terms are typically dependent on the bulk
velocity through the medium, with isotropic and orthotropic models typically available. In addition
to providing a momentum source term, modifications to the model can also implement energy and
turbulence source terms.

Porous media models are typically used to model:

• Packed bed reactors

• Filters

• Grate and screen structures, and

• Fibrous materials

The model inputs (parameters) used to modify the momentum source terms are typically derived
from either empirical relations (Ergun, etc...), or through physical testing values. PVP2008-61621
describes modifications to basic by region turbulence modeling on a packed bed that allow the
prediction of bed bypass due to the reduction in packing fraction at the near-wall location.

8.3 Radiation

In many cases, at temperatures relevant for PVP, radiation becomes a fundamental mode of heat
transfer. Commercial CFD solvers allow the inclusion of radiation through two methods, surface-
to-surface and participating media.

Surface-to-surface methods assume that all of the model surfaces surrounding the fluid domain are
opaque. In this case ray tracing methods are used at the start of the solution to determine the
view factors between boundary cell faces on the model. During solution, the temperature difference
between cell faces is coupled with the standard Stefan-Boltzman law to determine the transferred
radiative energy. The iterative solution of the energy equation then allows for determination of the
final temperatures, with radiation included.

Participating media models also perform ray tracing to determine the view factors between cells;
although, due to the inclusion of participating media, the ray tracing is performed on an iteration-
by-iteration basis. This results in increased computational requirements for the solution of this
model.

Both methods typically allow the consideration of multi-band and gray thermal models.

8.4 Multi-Component Flows

As seen in Example 1, it can be necessary to consider multi-component flows to accurately capture
the problem physics. Multi-component flows can be classified as follows:

• Multi-Component
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• Volume-of-fluid

• Lagrangian

Each of these models is described below.

Multi-Component

Multi-component models are used to simulate miscible mixtures of either fluids or gases. In stan-
dard implementations the mixture components must all belong to the same phase. The model
calculates local composite fluid properties based on the concentration of each species within the
computational cell. Modifications to the model allow reaction modeling between species defined in
the model.

The mixing tank example used the multi-component fluid model.

Volume-of-Fluid

The volume of fluid (VOF) model is used to simulate immiscible mixtures of fluids and/or gases.
The VOF model resolves the interfaces between the phases through numerical techniques. A re-
quirement of the model is that if it is used to resolve small structures in the flow, such as bubbles,
the grid density must be such that each small flow feature is captured by at least three cells. Some
uses of the VOF model include weir and open channel flow, tank sloshing and boiling simulations.

Two animations demonstrating VOF flow are included with the course materials.

Lagrangian

The Lagrangian phase model is used to model dispersed phases, such as droplets, bubbles or parti-
cles, within a continuum. The model operates by tracking parcels of the secondary phase. Typically
parcels do not model individual particles within the flow; instead, they represent a statistical quan-
tity (mass) of the phase. Additional models allow for the consideration of volatilization, reactions,
film boiling particle break-up and coalescence.

Transient Analyses

Transient analyses can vary from LES/DES/DNS analyses of detailed flow phenomena with small
enough time-steps to capture convective flows on a cell-by-cell basis to long-term analyses per-
formed using RANS methods to eliminate the need to capture convective terms on a cell-by-cell
basis. Boundary conditions can be varied using tabular data or functions on a time dependent basis.

9 Summary

The following statements can be made based on the information presented in the tutorial:

• CFD analyses require considerable forethought if “correct” answers are to be obtained from
the analysis,

• Grid topology requirements for a given problem are based on past experience with similar
flow fields, and

107 of 110



USE OF CFD IN DESIGN 9 SUMMARY

• Intimate knowledge is required as to how selected models operate, including their requirements
and limitations

In short, properly modeling phenomena with CFD requires KNOWLEDGE and VIGILANCE.
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